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CHAPTER 1

1. Open ArcMap

a)

Tour of ArcMap

o)

Start ArcMap by double-clicking on the ArcMap icon on your desktop. If anicon is not

present, you can use the Start Menu instead. Usually, you will find ArcMap if you click on:
START BUTTON> PROGRAMS> ARCGIS> ARCMAP 10

b)

map or make new map using a template” heading on the left.

c)

blank map in ArcMap.

When the Getting Started window pops up, click on New Maps under the “Open existing

Under My Templates, select Blank Map. Click OK at the bottom of the window to open a
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The ArcMap Graphical User Interface (GUI) will look something like what you see below. If it looks
slightly different, it's because additional functionality (toolbars, etc.) may have been turned on or

enabled by a previous user. When ArcMap is closed, it “remembers” these settings and restores them

when it is reopened.

Explore the ArcMap Interface. As you hold the mouse pointer over a button, a description of its function
will appear in a small box below it. Take a few minutes to try out this technique. As you mouse over some

of the icons and buttons, try to familiarize yourself with what each one does.



Some of the major “areas” of the ArcMap interface are labeled below.
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2. Docking toolbars

Toolbars in ArcMap are sets of tools that perform similar types of functions. The Tools toolbar includes
tools for navigating around the map display and tools for performing basic query functions. All toolbars
can be moved around the ArcMap interface and can be “floating” windows or docked to the left, right, top
or bottom of the GUI. The position of toolbars can be manipulated by clicking on the “handle” on its far

left side and dragging it to a new location.

Try moving the Tools toolbar around the ArcMap window. You can even drag it to a location on

a)
your desktop that's completely off the ArcMap GUI, just try not to lose it!
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b) After you have finished experimenting with new toolbar locations, move the Tools
toolbar back to its original position.

3. Add Data

Now that you are familiar with the ArcMap GUI, let's explore some GIS data. In this step, you will add
data to your ArcMap document. An ArcMap document does not contain the data itself, but rather
includes layers that point to data sources. In this training course, you will be using the VCGI training
dataset, which can be acquired at http://vcgi.vermont.gov, by clicking “Data and Imagery” on the left
side of the screen, then “products”, then the download icon & to the right of “VCGI Training Data”

a) In ArcMap, click on the ADD DATA button. & -
b) Navigate to C:\INTROGIS\DATA\TransRoad RDSMAJ1_LINE. Click Abp.
c) Click the ADD DATA button again, and then navigate to

CAINTROGIS\DATA\BOUNDARY_TWNBNDS_POLY. Click Abp.
d) Click the SAVE button and navigate to CAINTROGIS\PROJECTS\ F'-;l

e) Save your map as Exercisel.mxd.



4. Explore the Table of Contents

The TABLE OF CONTENTS is the pane at the far left of your screen that lists the data layers that you
have added to your map document— in this case BOUNDARY_TWNBNDS_ POLY and
TransRoad_RDSMAJ1_LINE. You will work within the TABLE oF CONTENTS anytime you are in ArcMap
— it is the place to go to access layer properties, attribute tables, and more. Right now you will just get
used to the way ArcMap draws data layers.

a)

b)

c)

Note that TransRoad_RDSMAJ1_LINE is at the top of the TABLE oF CONTENTS, and
BOUNDARY_TWNBNDS_POLY is below it. ArcMap always draws layers from the bottom of
the TABLE OF CONTENTS up, so in this case towns are drawn first, and roads are drawn on top
of them. Click on the layer name BOUNDARY_TWNBNDS_POLY and drag it to the top of the
Table of Contents. What happens?

(You should see that the towns now cover up the roads, because they are drawn on top of
the roads layer.)

Return BOUNDARY_TWNBNDS_POLY to its original position below
TransRoad_RDSMAJ1 LINE.

Click the check box nextto BOUNDARY_TWNBNDS POLY on and off. Notice the effect this
has. If you like, turn off TransRoad_RDSMAJ1_LINE and leave it off for a while — this layer
can take a while to redraw

5. Use the Tools Toolbar to Navigate Within Data View

Let’s start exploring some GIS data. The Tools Toolbar, usually located either horizontally at the top of
the screen or vertically at the far left of the screen, has eight tools to help navigate. It also has several
other tools to help you with basic functions like selecting and identifying features, measuring distance
and area, and finding XY coordinates on your map. The most common tools are briefly described

below.

Tools Toolbar
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Navigation Tools

Selection Tools

- ldentify



Take several minutes and try using each of the first 8 navigation tools on the TooLs TOOLBAR to see how
each one works. If you get stuck or lose your place, you can always click on the Earth icon on the toolbar.
This is the FuLL EXTENT tool. It will restore the map display to its full extent. We will get to some of the
other tools later.

a)

b)

You can explicitly set the display scale of your map by typing a value into the scale window on the
STANDARD TOOLBAR. Try typing in something like “1 inch = 1000ft.” You can also select from a
set of predefined scales. This set of scales can be customized to include a user defined scale.
Giveitatry.

Use your mouse to Pan and Zoom. If your mouse has a scroll wheel, you can use it to zoom
in and out and to pan around the display area. Rotate the wheel forward to zoom out and
backwards to zoom in. Hold the wheel down and then move the mouse to pan around the
display area. This can be a real time saver!

B [
Bristol Flainville New Britain | Newington |
]
‘moutl

[—— Rody Hill
B b
e _’M_._-‘-"”'_F_
o

Hold down to panm

Berlin Cromwell

e[

2

& S Southinaton ETFH_'_I’_’AJ—\"“'W_Q\A /
1Y
N - |
N
ey

Waterbury ;.l" Mic

:n i 1Y
//.4 | \
il Middlefield |
Cheshire 3
Prospect \\“\'_'___J‘ Lﬂ_ﬁd—-—

I atuck l "_F._‘m
= —
_j\x /JJ Wallingford j Durham i

6. Use the Identify Button ﬂ

The Identify button is very handy — it will report to you all of the attributes for any feature that you click on
in your map. By default it works on the top-most visible layer in your TABLE OF CONTENTS, but you can set
it to identify features from a specific layer, from all visible layers, or from all layers.

a)

b)

Click on the IDENTIFY button in the TOOLS TOOLBAR, and then click somewhere in your map. If
TransRoad_RDSMAJ1_LINE is turned off, then you will get information for whatever town you
clicked on. If roads are visible, then you will get information for whatever feature you clicked on
—aroad or a town.

Experiment with drawing a box with the IDENTIFY button (this will give you multiple results) and
with changing the layers that the tool works on.

10
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crarter2  ASKING GIS questions and planning
a Mapping Project
Spatial Concerns

When we think about how GIS can be used to help solve problems, we are simply incorporating the idea of a
spatial perspective. An example might be to consider where a new landfill should be placed. You would want to get
a map of rivers to make sure you are not too close to running water, a map of geologic cover types to make sure
you place it on top of relatively impervious clay and bedrock, a slope map to minimize the damage that potential
spills might cause by choosing flat ground, a map of residential locations to keep it away from people, etc.. These
are spatial concerns, and these pieces of spatial information can all be quickly utilized in a GIS environment such as
ArcMap, assuming the data has already been collected, which it often has. This thought experiment is referred to
as a Suitability Analysis. In a suitability analysis, you are considering where something should/can exist, and you
utilize the relevant spatial data to help you come to that decision. This is a common form of GIS analysis. If
everyone in interested and if time permits, you will perform a suitability analysis at the end of this training course.

It is always a good idea to plan a project, and planning a mapping project will save you time
and inconvenience! There are a few basic tasks to perform in order to plan your project:

1. Determine the scope of your project
a. Geographic Area:

b. Topic/focus/goal:

2. Audience:

a. How you will share completed project with audience (online,
paper,
etc.):

3. Data needed to complete project:

a. Source(s) of data needed:

b. How you will acquire or create the data:

4. Project partners or participants:

5. Funding:

6. Legal/privacy issues?

12



CHAPTER 3 Acquiring Data

Data is now available from many sources online. Many states, including Vermont, stream data over the
internet, and you can add these data services to your map. ESRI also has a service called ArcGIS
Online to which users can post data, and from which you can stream or download data. In this
exercise, you will see how to access these online data sources. Note that when you stream data, you
are not actually downloading it onto your local computer — you will need an active internet connection
to view the data.

1. Add Data from ArcGIS Online (if you have access to an account)

a) First, start a new, empty map.

& -
b) Thenclick the Add Data button, ' ™~ and browse to
CAINTROGIS\DATA\BOUNDARY_TWNBNDS_POLY.shp, and click add

c) ltis very easy to add data from ArcGIS Online — you can do so directly from that same AbD DATA
button on the STANDARD TOOLBAR

Nl s Bx o & -| 11:1,400.000 v « EEES
RVMDBO DD W #eex P A0
Tabke Of Contents Add Basemap
1o R = =53 Add Data From ArcGIS Crine

=

This time, instead of clicking in the middle of the AbDD DATA button, click on the tiny triangle just
to the right of it. This will provide a sub-menu of options.

Choose AbD DATA FROM ARCGIS ONLINE.
When the ArcGIS Online window opens, you can type in a search term, such as “Imagery”,
“Elevation”, or “Soils”.

Choose one of the results that you find appealing, and click DETAILS. If you want to add that
layer to your map, click ADpb.

It may take a little while for the data to load. When it does, zoom in and explore the data set. Is it
what you expected?

2. Explore VCGI's Vermont GIS Data

VCGil is a public non-profit supported in part by the State of Vermont (through the property transfer tax)
and in part through grants and fees paid for the products and services it provides to clients (e.g. the VT
Agency of Transportation and the VT Enhanced 9-1-1 Board).
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The storage and provision of free digital geographic data created by members of the VT GIS community
are two of the most important tasks that VCGI performs. Anyone can visit the VCGI Data and Imagery
section of the website to download this GIS data. Newer aerial photographs and some data layers, are
available as Web Map Services (WMS).

a) Open a web browser and go to http://vcgi.vermont.gov

b) Click on the Data and Imagery button to the left on the front page

then click on the Go button
C‘H'howtogatpo\sonwyu\\outofshn P‘ ‘ ﬁ' * E % @‘

Statistcs | | Orals | | RSImagery | | SEA | | WindMap & bill gates stuff | | AAG 2012 (%) Cell phone cancer | Computer buids 3. GPs

c)  Type Airports into the Keyword search a

& @ & vcgivermont.gov

_ Jobs _ EmallandBanks | | Food | FunnyandHobby | | GISTools | | SchoolandR

vermont.gov > vegi » Welcome ¥

Vo ght Center for fosean

VERMONT .cov
official state website

| About VCGI

.
|Data andimagery M

[
| Resources

| Map Center

|Educatl0n and Training

| Events

Welcome to VCGI's Website!

David Brotzman VCGI is your source for Vermont's geospatial data, information, and activities. VCGI is a public
Exscutive Dreclir non-profit chartered by the State of Vermont to assist the Vermont GIS community as well as anyone
56 South Main St interested in geospatial iechnology or mapping.

Watertiy VY 05670
d) See what information is provided in the search results table

e)  We will not download any data to the workshop computers, but this is something you can do
from your home or office computer (wherever you have ArcGIS available).

3. Stream Data via VCGI's Web Map Service (WMS)

Rather than requiring users to download full datasets (shapefiles, geodatabases, imagery, etc.) from their
websites, many data providers, including VCGI, are making some of their datasets available as live

map services. This is very helpful for many users, as they have access to the newest datasets
automatically, without having to download anything to their computers. The downside is that to display
the data, you need a live (and fast) internet connection.

Currently, VCGI is providing Web Map Services (WMS) of much of their imagery as well as a basemap
(many layers), contours, hillshade, and USGS topographic maps.

In this exercise you will connect to VCGI's Web Map Services

a) Click on Data and Imagery on the VCGI website’s main page

b) Click on “Web Services”, then “How to Use Web Services” (this will appear just below “Data
and Imagery”)

¢) Highlight and copy the URL provided in step 5 of the “Connecting to GIS Servers in ArcGIS”
section

14



d) In ArcMap, click the Add Data button.

e) Click the Lookj
Add Data

Look in:™ |E3 GIS Servers

&l Home - GISharcGls
Mame 8 Folder Connections

SAdd Al e

HHadd A enas

Sadd W) 5 cnasedin

+ =
SEAAd W = CoceEdimResults
G z005_1 SO R

drop-down arrow and navigate to the GIS Servers folder.
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b & D:hd-cd2 ;
o e e
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22010 == nttp:fbroadba...
ﬂ arcgis E&l Tracking Connections Tr:jmttp):rff-‘m aps..
{5l Coordinate Systems
Marme: [

Add

Cancel

f) Double-click Add ArcGIS Server.
g) Make sure “use GIS services” is chosen, then click Next

h) In the General window, enter the URL you just copied: it should be:
"http://maps.vcgi.org/arcgis/rest/services/" (remove the quotation marks) — don’t enter anything

for a User Name or Password. Click Finish.

i) Double-click the new ArcGIS server (it will now be listed in this GIS Servers Add Data window)
i) Double-Click on the folder containing the service you wish to connect with (basemap is in
VCGI Services, everything else is in EGC services)

k) Click on the service you want to add, then click Add.
i) Explore the data you have added using the Tools toolbar

Now you will add a WMS of aerial photos using a ‘Layer File’

a)
b)
c)
d)
e)

f)

g)

Click on Data and Imagery on the VCGI website’s main page

Click on Web Services

Click on Imagery Services

Click on the first bullet under ‘Best of Black and White Imagery, Cached, VT State Plane Meters”
It should say “Link to layer file (opens in ArcGIS 10+)"

A window will pop up asking you how to handle the file, it should say “open file with...ArcGIS file

handler”, click OK.

Return to ArcMap, you should see that the Best of Black and White Imagery layer has
been added to your project.

Explore this data along with the other data you have added

Additional Data Sources:
The National Atlas (http://nationalatlas.gov/atlasftp.html)

The Census Bureau (http://www.census.gov/geo/maps-data/data/tiger.html)
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CHAPTER 4 GPS and Tabular Data

Collecting GPS data is a common way to get locational information into your GIS. GPS units generally
save their data in a .GPX format. ArcGIS v.10.2 can import .GPX data, which can then be transformed
into shapefile format.

1. Import .GPX Data

GPXis a common GPS data file interchange format. In this exercise you will convert a GPX file to
a shapefile.

a) Startanew, empty map and add BOUNDARY_TWNBNDS_POLY.shp toit. Note that by
adding a data layer with a known spatial reference (like
BOUNDARY_TWNBNDS_POLY.shp, which uses VT’s standard coordinate system: VT
State Plane, units = meters, and datum = NAD 1983), the data frame is assigned that spatial
reference. Add TransRoad_RDSMAJ1_LINE.shp as well.

=
b) Click on the ArcToolbox icon

c) Click the plus sign next to Conversion Tools, then the plus sign next to From GPS
d) Double-Click on GPX TO FEATURES.

16



d) Navigate to the GPX file “CAINTROGIS\DATA\vcgipts.gpx”, then adjust the Output Feature
class as the instructor indicates and click OK. It takes a minute for the new layer to appear

..a' GPX To Features =10l x|
. =]

Input GPX File GPX To Features
I C:\IntroGIS\DATA \Wegipte. gpx B

Output Feature dass Converts GPX files into features.

| C:\IntroGIS\DATAWegipts.shp | Y

[ [~

QK | Cancel | Environments. .. | <« Hide Help Tool Help |

e) Rightclick on the new layer and click Zoom To LAYER.

2. Re-Project Data

Note that the GPX to Features dialogue does not give you very many options -- it does not give any ability
to define coordinate systems (input or output), attributes, data types, etc. You will have to manually attend
to each of these.

a) Double click on your new layer to open its properties.

b) Click on the SouRcCE tab, and check out the spatial reference for the GPS data

Its coordinate system is GCS_WGS_1984 -- a geographic (not projected) coordinate system, and a
common one used for GPS data. This is not the coordinate system used by your data frame or the other
layers in your map, but that does not prevent ArcGIS from being able to draw the data in the proper
place, because it performs Coordinate Reference System Transformation on-the-fly.

You could simply leave the dataset in its current coordinate system, but that could be confusing for other
users of the data, who have come to expect VT's standard spatial reference (VT State plane, meters,
NAD 1983). Also, if this dataset were ever the first added to a new dataframe, the dataframe would take
on its spatial reference, which again can be confusing and make other data sets behave strangely.
Finally, accuracy may be improved when all the layers in a data frame share the same spatial reference -
- especially if they will be used for any geoprocessing tasks. Therefore, we will take a minute to project
the data into VT's standard spatial reference.

In ArcToolbox, browse to DATA MANAGEMENT TOOLS> PROJECTIONS AND TRANSFORMATIONS
> FEATURE > PROJECT (double-click).

NOTE: Do NOT open the tool called “Define Projection” -- all this does is write a text file stating what the
projection is (or actually, just what YOU have said the projection is -- you could in fact define the
projection incorrectly! For example, if you accidentally ran that tool now, you would write a projection file
saying that the Waypoints shapefile uses NH Stateplane coordinates, but in fact it would still be in its old
WGS 1984 geographic coordinates.)

17



c) Setyourinputlayer and define the output location and name.

d) Click the icon on the Output Coordinate System line to choose a pre-defined coordinate system.

rl'i\ Project v " sl

Input Dataset or Feature Class
[waypaints =] E
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+
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1
4
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— = ]

e) In the window that appears, type Vermont in the search area, open Projected, State
Plane, and NAD 1983 (Meters). Click on NAD 1983 State Plane Vermont FIPS 4400(Meters).

Q) Untitied - ArcMap.
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fte o=
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f) Click OK. NAD_1983_StatePlane_Vermont_FIPS 4400 should now be listed as the output
coordinate system. Click OK. — Now open the properties of this new layer and look at the spatial
reference information under the Source tab

Note that using the Project tool creates a new dataset -- it does not simply project the existing dataset.
3. Add X,Y Coordinate Data to ArcMap

In addition to data sources such as shapefiles and TIF images, you can also add tabular data that
contains geographic locations in the form of x,y coordinates to your map.

In this exercise, you will add a text file containing points defined with latitude and longitude.

a) From the FILE menu, select ADD DATA, then ADD XY DATA

@ coinama i Ao

Flle_Edlt View Bookmarks Insert Selection Geoprocessing Customize '

O Mew. CtrleN |- 14589 X EAEEE
B Open. Cirl+0 |, Al Editor=|[>
B Save Ctrl=S | -
Save As_
Save A Copy_—.
Add Data v & Add Data
B signin_ BE  Add Basemap.
Y ArcGIS Online... HE Add Data From AscGIS Online..
B3 Page and Print Setup... £  Add XY Data..
W Print Preview... Geocoding »
& Print.. W Add Route Events...
&l Create Map Package.. K __-ﬂdd QL_lery Layer... 3
Export Map—
™ Map Document Properties—
1 CAlntroArcl. \Editing,mxd
2 CAGISVWUNH_\Editing.mxd
3 _\Census_Exploration.mood
4 CAGIS\ A\NH_Browser.mud
5 CADriversPe_\Census.mxd
6 _\SPNHF_NAIP Workemxd
7 -\Deerfield_Browser.mxd Wi
& _\Composite_AllFocalAr...
9 _\LampreyConservation...
Exit AltsFa

b) Click the BRowsE button, and browse to the file CAINTROGIS\NH_Dams.csv.

c) Specify “Long” as the X FIELD, and “Lat” as the Y FIELD. Don't click OK yet!

d) Click EpiT to change the coordinate system for the input coordinates. You need to tell ArcMap
that the coordinates in this new file do not reference VT's standard spatial reference. Rather,
they are unprojected (“geographic”) coordinates -- latitude and longitude. We will assume that
they are registered to the WGS 84 spheroid, the most common way that GPS data are
registered.

e) Open the folder for Geographic Coordinate Systems. Within that, browse to World, and select

the last one in that list: WGS 1984. Click OK, then OK again
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x

A table containing X and ¥ coordinate data can be added to the
map as a layer

Choose a table from the map or browse for another table:

I MH_Dams. csw j Ei‘l
rSpedify the fields for the X, ¥ and Z coordinates:

X Field: IP_Ion_dec j

¥ Field: P_lat_dec j

Z Field: [Elev_m =]
~Coordinate System of Input Coordinates

Description:

Geographic Coordinate System: ;I

Mame: GC5_WGS_1934

ki

[ Show Details

W Warn me if the resulting layer will have restricted functionality

About adding XY data oK Cancel

f) You may get a warning about the lack of an Object-ID field -- read through it, and then click OK.

Table Does Not Have Object-1ID Field x|

The table you spedfied does not have an Object-ID field so you will not be
able to select, query, or edit the features in the resulting layer, or define
relates for them.

After you create this layer, you can export it to a shapefile or feature dass if
you need these functions. To export a layer, right-dick it in the Table Of
Contents and choose Data>Export Data. Add the exported data to the map
as a new layer.

Cancel |

g) Rightclick on the new layer in the TABLE OF CONTENTS and select Zoom TO LAYER.
This new layer is a type of temporary file — to make it a permanent layer it must be exported
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4. Save X,Y Coordinate Data as a Point Shapefile

a) Rightclick on the new layer in the TABLE OF CONTENTS and select DATA - EXPORT DATA.

b) Choose to export all features, using the same coordinate system as the data frame.

NOTE: Depending on your version of ArcGIS, the dialog box may appear slightly different...
just make sure that you are causing the exported data to inherit the coordinate system of the

current dataframe. This is especially important if you started with Latitude/ Longitude (or other)
data and want it to end up as VT Stateplane data.

Export Data x|

Export: Al features j

LIge the same coordinate system as:
this layer's source data

%' the data frame

" the feature datasek vou export the daka into
(only applies if wou expark ba & feature dataset in a geadatabase)

Output feature dass:

CAINTROGIS DataWH_Dams.shp ﬂl

K. I Cancel
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CHAPTER 5 ArcCatalog

1. Open ArcCatalog as a Stand-Alone Program

Now that you have some familiarity with the ArcMap interface, we will open the stand-alone version
of ArcCatalog. (There is also a way to open ArcCatalog (with limited functionality) within ArcMap —
we will do that later.

ArcCatalog is the place to go to manage your data — to move or rename files, to browse through
and preview your data sets, to create new empty shapefiles or geodatabases, etc.

a) Click the ArcCatalogicon on the desktop or, from the Start menu choose ALL PROGRAMS
> ARCGIS > ARCCATALOG 10.

b) ArcCatalogis structured somewhat like Windows Explorer — there is a catalog tree on the left,
and on the right you can see the contents of whatever folder you have selected in the catalog
tree. If you have navigated to a folder and selected a dataset on the left, you can preview it on
the right.

c) Inthe left-hand pane, navigate to:
CAINTROGIS\DATA\ENVIRON_MAREA2004 POLY.SHP.

d) At the top of the right-hand pane, click on the Preview tab.

7 ArcCatalog - C:\INTROGIS\DATA\ENVIRON_MAREA2004_POLY.shp
File Edit View Go Geoprocessing Customize Windows Help

LleE HE x| SHELEQERBBE g

[CAINTROGIS\DATA\ENVIRON_MAREAZ004_POLY shp
EfEIEY"

ORI I

s

| Conterts Preview | Description |

=l E3 Folder Connections
B £ C:y
B arcais
£ pell
E3 pos
B3 grass
[ hidedesktop
B ntel
B EJ INTROGIS
Bl £ DATA
[E]) BOUNDARY_CNTYBMDS_POLY .shp
[E) BOUNDARY_TVINBNDS_POLY. shp
[E) BOUNDARY_VTEND_POLY.shp
[E) CADASTRAL_CONSPUB_POLY.shp
[E]) DEMO_COUSUB2010_POLY.shp
[E]) DEMO_TOWNPOPN_POLY.shp
|j DemoCensus_COUSUB2010. txt
DemoCensus_COUSUB2010.xml
#5 ElevationOther_HILSH24. tif
€7 BlevationOther_HILSH24,prj
=} ErvIRON MAREA2004 POLY.shp
[%7) FACILITIES_PTSCHOOL_POINT.shp

[EC T —
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e) Notice that the same navigation tools (zoowm, PAN, etc.) and the IDENTIFY tool that we used in
ArcMap are available here as well. Feel free to zoom, pan, and identify features in the

preview pan

f)  Right now you are previewing the geography of this dataset. You can also preview its
attribute table. Choose TABLE from the drop- down list at the bottom of the preview pane.

g) Scrollthrough the table to get a feel for the type of information it contains. You will learn

more about attribute tables in the next exercise (and throughout this workshop).

2. Open ArcCatalog within ArcMap

a) When you are finished exploring the ArcCatalog (stand-alone) interface, click the X in the

upper right hand corner of the window to close it.

Note: it is generally worthwhile to close ArcCatalog if you are not actively using it, as it can
sometimes lock up your data files and make it so you cannot edit them or make any
permanent changes (like adding attribute fields) to them.

b) Returnto your ArcMap document.
¢) You will now open an ArcCatalog window within ArcMap.
d) Click the ArcCatalogicon in the STANDARD TOOLBAR.
NS B x o o &.[[11548598 v EBEE D 3 a2
Opens the ArcCatalog
pane within ArcMap
e) An ArcCatalog catalog tree should appear. Depending on how the last user on your computer

left it, the catalog tree may be floating in the middle of your screen, or it may be docked at the
far right side of your screen. (It could actually be docked at the top, left, or bottom of your screen
also, but most people seem to dock it to the right.)

3. Dock the ArcCatalog Window

a)

b)

One useful feature of ArcGIS 10 is the ability to dock all sorts of windows (such as
ArcCatalog, attribute tables, the Identify results window, etc.) along the edges of the

interface.
If your ArcCatalog window is already docked, grab its blue title bar and drag it to the center of
your screen to un-dock it.

To dock a window in ArcMap, click on its blue title bar and—uwith the mouse button still
depressed—drag it a little bit. As you drag it, you will see sets of blue triangles (anchors)
appear. Drag the window until your mouse pointer is on top of the right-most blue anchor
triangle, and then release the mouse button.
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Catalog
. & @ &
Location: L Home - GIS\ArcGIS
) \ = 5 Home - GIS\WcGIS
| # £3 Addins
» / # (3 Packages
< ¢ 2 Default
* @ Toobox
# G Folder Connechions
# B Tooboes
# I Database Servers
# Lo Database Conmechons
# {{J GIS Servers

=

|3

Drag your mouse
pointer to this
anchor, then
release the
mouse button

c) This technique works for many of the windows that you will use in ArcMap, though using the
anchors at the sides of the interface has a slightly different effect than using the anchors at the

center of the screen. As you work in Arc-Map, feel free to experiment with these different anchor

locations.

d) Once ArcCatalog is docked, a small pushpin icon appears in its title bar, next to the X. If the
pushpin is vertical, the docked window will always be visible. If the pushpin is horizontal, the
docked window will autohide—that is, it will dis-appear until your cursor hovers over it.

e) Click the pushpin to change whether your window autohides or not. Leave it in whichever
position you prefer. Note that you cannot drag the window about if Autohide is ON.

4. Add Data from ArcCatalog

a) Inthe ArcCatalog pane, expand the Folder Connections folder, and then browse to

CAINTROGIS\DATA\ENVIRON_MAREA2004_POLY.
b) Click on CADASTRAL_CONSPUB_POLY.shp and drag it to the left, into your map document.

This is an easy way to add data to a map document (though unlike using the Add Data button,

you can only add one layer at a time) — Explore this data

c) Save your map. (Do this regularly!!)
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5. Manage Data in ArcCatalog

You can copy, paste, move, and rename data layers in ArcCatalog, as well as create new folders,
shapefiles, or geodatabases. In this example, you will make a backup version of a shapefile and rename
it with today’s date.

Catalog 2 x
a) Rightclick on ENVIRON_MAREA2004_POLY e @ £ %
In ArcCatalog and choose Copy. Location: |[E consnhCopy.shp v
. . = &) Home - GISVArcGls ~
b) Right click on the folder name DATA and 5 £ Addns

# [ Packages
% |3 Default

Choose Paste.

# & Toobox
. = [E3 Folder Cornections
c) A new shapefile called 5 E1Ch
ENVIRON_MAREA2004_ POLYcopy is created. £ 4b4003a182c000 700641144
i . # B Arcatold
e) Rename the shapefile: Click once to select the # £ Arcoworkshop
. . . . # B bab179bcdab 31346026 2bca
new shapefile, and then click again to make its % B boot
name editable. (If you have trouble doing this, just - ggggggﬁqupress
right click on its name and choose Rename.) % £ Del
Give it the name . g Documents and Settings
Marea2004_BackupYYYYmmdd = £ DriversPermit1o
- = £ BaseData
# £ Cersus

= B3 ConservationLand
+ @ AttrbuteCodes

7. Optional: View Datasets Using kL ——
Windows Explorer o P s
# (5 Roads

# i atarchade

You just created a new shapefile using ArcCatalog. It was very easy to do: just copy, paste, and
rename one file. However, what really happened was a little more complicated: seven files were
copied, pasted and renamed. You can see that this is what has occurred if you open Windows
Explorer to view the files within your shapefile.

The purpose of this step is simply to better understand the files that contribute to a shapefile, and why we
use ArcCatalog rather than Windows Explorer to manage data. You will not be making any changes within
Windows Explorer.

a) Rightclick on the Start button and choose Explore.
b) Browse to C:\INTROGIS\DATA\ENVIRON_MAREA2004_POLY

c) Notice how many files are present. A shapefile is not a single file — it is a collection of three
or more files with the same first name (such as ENVIRON_MAREA2004_POLY) and
different suffixes (*.shp, *.dbf, *.shx, *.sbx, *.prj, etc.)

d) Using ArcCatalog to manage your data means fewer steps for you — instead of copying, pasting,
renaming, or moving three or more files, you only have to work on one. It also—vitally—means
far fewer chances for error. It is far too easy to accidentally leave out one of the sub-files
contributing to a shapefile, or make a typo and mis-name just one of them. Either of these
mistakes can be hard to trace back and will make the shapefile unusable.

25



CHAPTER 6 Attribute Tables

In this exercise you will explore the attribute tables for the layers in your map and learn how to select
features based on their attributes or their location.

It may seem strange to focus on the task of selecting features based on their attributes or location, but in
fact, making selections is a very useful way to examine your data, and is a frequent first step in analyses.
For example, if you were working on a project based in a specific town, your first step might be to zoom
to that town in your view. You could do that by first selecting the town, and then choosing to zoom to
your selected feature. Your next task might be to sub-set a number of statewide datasets (such as roads
or streams) to just the area of your town. To accomplish this, you would also need to first have your
town selected.

1. Use Select Features Tool

a) Ifit's not already open, open ArcMap and the map you were working on earlier: Exercisel.mxd.
b) Click on the SELECT FEATURES tool on the TooLs toolbar K- and then click on a feature in
your map.

c) Any feature or features that you selected should now be outlined in bright turquoise.

2. Set Selectable Layer(s)

Particularly when using the Select Features tool, it can be very difficult to figure out what you've
selected once you have clicked somewhere. In the step above, you may have selected some roads and
a town or two with just one click of the tool. There is, however, a handy way to control what can get
selected: the List By Selection tab.

a) Click the 4" icon from the leftat the top of the TABLE OF CONTENTS — the List By Selection

tab.
A [T

=] Selected
% BOUNDARY_TWNBNDS... [ [ 1

b) The “regular” TABLE OF CONTENTS view shows you which layers are visible and in what
drawing order; the List By Selection view instead shows you which layers are able to be
selected and how many features in each are currently selected
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Table Of Co

“: 8 G|
Selected
% CADASTRAL_CONSPUE... [4 [4 2

& SAMNDBAR STATE PARK
8 SANDBAR WILDLIFE MAMAGEMENT

5 BOUNDARY_TWNBNDS... [ [ 2

& MILTON

& SOUTHHERO
=] Selectable (no features selecte
ANS_RDSMAJ1_LINE  [4

Ry

c) Inthe example above, all layers are selectable, but only the town bound
features have features selected| BOUNDARY_TWNBNDS_ POLY_POLYYas 2 features
selected, and they are listed by name — the same goes for CADASTRAL_CONSPUB_POLY.
Experiment with this tool a bit.

d) If you had only wanted to select fowns, you could click the Clear Selected Features button next
to the selection results for CADASTRAL_CONSPUB_POLY, and only the 2 towns would
remain selected.

e) On your screen, Clear selected features on one of your layers, and then make it NOT
selectable by clicking the “Click to toggle selectable” button next to it.

f) Returntothe “regular” Table of Contents view by clicking on the firsticon from the left at the top
of the Table of Contents: List By Drawing Order. It is probably a good habit to return to this
Table of Contents view, because you will frequently want to do things like turn layers on and off
and rearrange the drawing order.

3. Open and Dock an Attribute Table

a) Rightclick on the name BOUNDARY_TWNBNDS _POLY in the TABLE OF CONTENTS, and choose
OPEN ATTRIBUTE TABLE.

b) Drag the attribute table down and dock it at the bottom of the screen.

ex: If you drag the table by its blue title bar down to the bottom of the screen until the four- way
arrow appears. Hover your mouse pointer over the down arrow, and the table should dock.

If you like, turn on AuTo HIDE by clicking the thumbtack in the upper right hand corner of the
table.
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A menu

is available from an OPTIONS icon at the top of the table. Other common tasks (Select

by Attributes, Switch Selection, Relates) are represented by icons at the top as well.

Options Related Selectby Switch Clear Zoom to Delete
Tables Attributes Selection Selection Selected Selected

Button

T TEE
pbp e
| [ FID | Shape* | AREA | PERIMETER | PB_| PB ID | FIPS | NAM| A

0 Polygon 8120911500 564363 63 2 1 7160 Pittsburg

1 Polygon 1738732000 2194865 3 2 7040 Clarksville

2 Palygon 538022910 104318.3 4 3 7005 Atkinson & Gilmar

3|Polygon 1307634000 178369.7 5 41 7190 Stewartstown

4 Polygon 1166271000 139129.91 B 5 7175 |Second College

5 Polygon 1370192000 166006.91 7 B 7075 Dixville

6 Polygon 559462530 105578.8 8 7 7070 Dixs Grant

7 Paolygon 1137201000 165905.7 9 8 7045 Colebrook

8 Polygon 1708427000 189406.59 10 9 7050 Colurnbia

9 Polygon 536926080 112868.3 11 10 7210 Wentworths Locat

10| Polygon 1935938000 176429.5 12 " 7085 Errol

11 | Polygon 1260530000 144672.09 13 120 7140 Millsfield

12 Polygon 104616900 42764129 14 13 7090 Erwings Location ¥

>
‘ 0 » » [E]B ©outof 259 selected)

c)
d)

e)

Click the ADD DATA button and add C:\INTROGIS\DATA\WWATER_WBD8VT_POLY.shp

Right click on WATER_WBD8VT_POLY.shp and select Open Attribute Table. Notice that
the WATER_WBDS8VT_POLY.shp attribute table is docked as well, right where the
BOUNDARY_TWNBNDS_POLY table had been. The BOUNDARY_TWNBNDS_POLY
table is still open, and is accessible from a tab at the bottom left.

Table
EELELT:
WATER_WBDVT_POLY

FID | Shape | HUC_8& SUBBASIN
Polygon | 02010007 | Mi River

Polygon | 01080101 | Upper Connecticut. New Hampshire, Vermont.
Polygon | 02010008 | Lake Champlain Direct

Polygon | 01110000 | Riviere Saint-Franceis

Polygon | 02010005 | Lamoille River

Polygon | 01080102 | Passumpsic. Vermant

Polygon | 02010003 | Winooski River

Polygon | 01080103 | Connecticut-Johns River to Waits River. New Hampshire
Polygon | 02010002 | Otter Creek

3

|~ @] mfw f~

<

T 1 m E (0 out of 17 Selected)

| BOUNDARY TWNBNDS.POLY | WATER WEDBVT_POLY |

You can also arrange the tables so they display side by side. To do so, grab one of the tabs
(BOUNDARY_TWNBNDS_POLY or WATER_WBDS8VT_POLY.shp) and pull it up toward the
center of the table until the blue docking handles appear. Click on the handle to the right, and the
table will dock to the right, just next to the other table.

Notice that the two tables share one set of tools at the top of the attribute table window (options, select by
attributes, etc.). These tools work on whichever table is selected — that is, whichever table’s title bar is blue.
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e

L Tl

| WATER_WBDBVT_POLY |

- B x
BOUNDARY_TWNBNDS_POLY X WATER WBDEVT_POLY.
FID | Shape | FIPSE TOWNNAME CNTY area len - FID | Shape m(:_x SUBBASIN
[ 0] Polygon | 9030 | CANAAN 5| 8568673532655 | 61300989948 1| [[»] 0| Polygon | 02010007 | M River
1 | Polygon 11040 | FRANKLIN " 106010610.8554 | 42589.883919 1 | Polygon | 01080101 | Upper Connecticut. New Hampshire, Vermont.
2 | Polygon 11015 | BERKSHIRE " 108619961.2223 | 41942.197875 2 | Polygon | 02010008 | Lake Champlain Direct
3 | Polygon | 11050 | HIGHGATE T4 154929649108 | 67363966095 3 [ Polygen | 01110000 Riviere Saini-Francois
4 | Polygon 11060 | RICHFORD " 111986463.50565 | 42397.279653 4 | Polygon | 02010005 | Lamoille River
S | Polygon 13005 | ALBURGH 13| 123066637 42045 55750.59866 5 | Polygon | 01080102 | Passumpsic. Vermont,
6 | Polygon 9080 | NORTON 9 100399227357 | 43903.673948 & | Polygon | 02010003 | Winooski River
7 | Polygon 9005 | AVERILL 9 99375243.80365 39817.04592 7 | Polygon | 01080103 | Connecticut-Johns River to Waits River. New Hampshire, Ver
8 | Polygon 19050 | HOLLAND 19 100238419.6869 | 40818.192289 ~ & | Polygon | 02010002 | Otter Creek
< n ] v o1 i
"o« 1 om E {1 out of 255 Selected) T 1r om E (0 out of 17 Selected)

f) Close the WATER_WBDS8VT_POLY.shp attribute table by clicking the X in its upper left

hand corner.

4. Select Features in an Attribute Table

In an attribute table, you can select features by clicking on the small gray box at the far left of a row.
You can click on just one row, drag down for several rows, or hold down the Ctrl key to select multiple

rows.

a) Experimentwith selecting towns by clicking on the gray box at the left. You can clear your
selection by clicking the gray box in the very upper left hand corner, or by clicking the CLEAR
SELECTION button at the top of the table.

w
a
o
=
=
L]
i a
a
5
2 § ¢ &
E s 2 &
R o L —
<337
- U =
) wi [ o
- O w o
%} =] = £
2 = 3 3
v = —
P A R ]
A A A \
| | |

-3 f O e

pbp x
FID | Shape* | AREA | PERIMETER | PB | PB ID | FIPS | NAME | coL
> 0| Polygon 8120911900 56436363 2 1 7160 |Pittsburg
1 Polygon 1738732000 219486.5 3 2 7040 Clarkswille
2 Polygon 538022910 104318.3 4 3 7005 Atkinson & Gilmanton
3 Polygon 1307634000 178369.7 5 4 7190 Stewartstown
il 4 Palygon 1166271000 13912991 b 5 7175 Second College
Click - 5 Polygon 1370192000 168006.91 7| 6 7075 Dixville
here to 6 Polygon 559462530 105578.8 8 7 7070 Dixs Grant
7 Polygon 1137201000 165905.7 9 8 7045 Colebrook
select 8 Polygon 1708427000 18940659 10, 9 7050 Columbia
9 Polygon 536926050 112868.3 1 100 7210 Wentworths Location
10 Polygon 1935938000 1764295 12 11 7085 Errol
11 Polygon 1260530000 144672.09 13 120 7140 Millsfield
12 Polygon 104616900 42764129 14 13 7090 Ervings Location G
1 Nalicmaem AL 400N 4 4NCTH O iC 14 TALA Svdall
< >
"o 1 » » [B]® (10 out of 259 Selected)
pbp
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b) Notice what happens to your map display as you select rows in the table.

c) After you have selected some features, try some of the other buttons and tools
— use the ZOoM TO SELECTED FEATURES, CLEAR SELECTION, and SwWITCH
SELECTION buttons — what happens?

5. Select By Attributes

The Select By Attributes dialogue lets you write a query to select features based on the values in
the attribute table.

a) Click the SELECT By ATTRIBUTES button at the top of the table window.

b) Selectall of Addison County by the following steps:
i. Double click on the field “CNTY”
ii. Single click on the = operator
iii. Click the GET UNIQUE VALUES button
iv. Double click on the number 1 (for Addison County)

¢) Your statement should read: SELECT * FROM BOUNDARY_TWNBNDS_ POLY WHERE:
"CNTY" =1 (Note that by clicking on the options as instructed above, you avoid having to know
whether/where to use single quotes/double quotes, etc. You are much better off doing it this way
than trying to type the statementin the dialog window!)

Select by Attributes 2
Enter a WHERE clause to select records in the table window
Method : Create a new selection =
"FID" 24| (P
FIPS6"
TOWNNAME 2
CHNTY"
area” -
S -
3 3
5 -
]
D Ca) [l | v !
Get Unique Values | Go To:
SELECT * FROM BOUNDARY_TWNBNDS_POLY WHERE:
"CNTY" =1
Clear ] [ Verify I [ Help ] [ Load... ] l Save.. ]
Apply Close

d) Click AppLY, then CLOSE. All of the towns in Addison County should now be selected.
e) For more guidance on writing selection queries, click the HELP button in the SELECT
By ATTRIBUTES dialog. ArcGIS’s Help is actually remarkably helpful, and frequently gives
very useful examples. Queries can be more complex than the ones we use here —
combining multiple expressions, incorporating wild- cards, involving calculations, and so
on. The help text gives many examples that may be quite useful to you.
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6. Select By Location

In this next step, you will select from one feature based on its geographic location relative to another
feature. Specifically, you will select all towns that Interstate 89 runs through (intersects). First you will
need to select I-89, then you will select towns based on their location relative to 1-89.

a) Clear any selected features you may already have by clicking the CLEAR SELECTED FEATURES

b)
c)

d)

e)
f)

)}
h)

k)

button on the TooLs toolbar. [

Right click on TransRoad_RDSMAJ1_LINE and choose OPEN ATTRIBUTE TABLE.

Click the Select By Attributes button at the top of the roads attribute table.

Double click on the field RTNAME then click the = operator, then click the GET UNIQUE VALUES

button.

Double-Click on I-89. Your statement should read: "RTNAME" ="'| 89'

Click AppLY and then CLOSE.

From the SELECTION menu, choose SELECT BY LOCATION.

Select BOUNDARY_TWNBNDS_POLY as the
target layer, TransRoad_RDSMAJ1_LINE as the
source layer.

Make sure the box “Use Selected Features”is
checked — otherwise it will search for any town
intersected by any road. You want it to only find
towns intersected by the selected road: Route 89.

Note that if you wanted, you could apply a search
distance — say, 10 miles — and find any
towns that were within 10 miles of Route 89.

Click OK.

Turn off the roads layer and, if necessary, zoom to
the full extent of NH so you can see the results of
your selection.

Save your map.
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Select By Location Ld_hj
Select features from one or more target layers based on their location in
relation to the features in the source layer.
Selection method:
[salect features from &
Target layer(s):
[] TRANS_RDSMAI1_LINE
[0 WATER _WED3VT_POLY
BOUNDARY_TWNBMDS_POLY
[ Only show selectable layers in this list
Source layer:
[+ TRANS_RDSMAI_UTNE =]
|¥] Use selected features (587 features selected)
Spatial selection method for target layer feature(s):
intersect the source layer feature i -
|| Apply & search distance
10000.000000 Meters
About select by location e | [ Apply ] | R
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CHAPTER 7 Joining Tables

As with any other database, you can bring in data tables and join them to the tables in your GIS. In order
to join tables, you need a field that is common to the two tables. For example, if you want to join
population data to your political boundary attribute table, you would need to have a field in the
population data that is the same as a field in the political boundary data. The political boundary data we
are using in these exercises would require that you have population data by town and have a field that
would identify the town by name or FIPS code. In this example, you couldn’t join tables that have the
population information by another geographic designation such as zip code because the shapes in the
political boundary data do not represent zip code boundaries, they represent town boundaries.

The fields in both tables do not have to be named identically in order to join the tables, but they do need
to contain the same information. For example, your population data may have a field entitled “Town”
while the political boundary data’s field is “Name”. You would simply indicate to ArcView that “Town” and
“Name” are fields to use for the join.

Although it is not necessary for the field names to be identical, it is necessary for the corresponding field
values to be identical in order for a join to be successful. In this example, it is important that the town
name be identical in each table. ArcView would not join the Income data to a record if, for example, the
town is identified as “North Hampton” in one data table and “N. Hampton” in the other data table.
The income data used in this exercise can be downloaded from: http://www.state.vt.us/tax/pdf.word.excel/statistics/2012/

1. Open ArcMap

a) Start ArcMap with a new empty map.

b) If you are not already in DATA VIEW, switch to it by clicking the DATA VIEw icon at the bottom of
the view window.

c) Click the SAvE button.
d) Navigateto C\INTROGIS\PROJECTS and save your map as income.mxd.

2. Join a Layer with a Table
a) Click the AbD DATA button, and browse to
b) C:\INTROGIS\DATA\DEMO_COUSUB2010_POLY.shp and click Add

c) Next add Median_income_2012.csv
d) Right-clickon DEMO_COUSUB2010_ POLY.shp.

e) SelectJOINS & RELATES, and then JOIN...
f) Select JOIN ATTRIBUTES FROM A TABLE.

g) Selectthe field NAME10 in Box 1.

h) InBox 2, The CSV You loaded should appear
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i)

p)

In Box 3, select Schoal District (Town)

for example, symbolize the la

yer's features using this data.
What do you want to join to this layer?
IJoin attributes from a table/ j

1. Choose the field in this layer that the join will be based on:

[raMELD 5

2. Choose the table td join to this layer, or load the table from disk:

IE Median_inconje_2012.csv j gl

V¥ show the attribute tables of layers in this list

3. Choose the field/in the table to base the join on:

ISchooI District (Town) j

 Join Options

A\l records in the target table are shown in the resulting table.
Unmatched records will contain null values for all fields being
appended into the target table from the join table.

] Keep only matching records

If a record in the target table dossn't have a match in the join
table, that record is removed from the resulting target table.

Validate Join
About jbining data oK I Cancel |

[
Check the first box (which is the default) to keep all records.

Click OK to join the tables.

If a Create Index window pops up, click YES to create an index. If you like you can read more
about indexing fields in HELP.

Right click on DEMO_COUSUB2010_POLY.shp, and select OPEN ATTRIBUTE TABLE.
Scroll across the table, and see that it now contains some fields about income.

Also notice that if you scroll down the table, a number of fields contain null values -- this can
occur for a couple reasons — either the names used for the same town are slightly different, or,
the data just don't exist in one of the datasets. This is more likely the case here. The income
data are split into school districts, which are not the same thing as towns, but the resolution of
these datasets are similar enough to almost be one-to-one

Close the attribute table.

Create Index El

The join figld in the join table you are joining to the target iz not indexed.

Wwiould pou like bo automatically create an index for the join field in the join table
now? Doing o will zignificantly improve performance.

LCancel

[ Usze my chaoice and do nat show this dialog again
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3. Save Joined Tables as a New Shapefile

Remember that the tables you have joined -- the attribute table from DEMO_COUSUB2010_POLY and the
income table, Median_income_2012.csv -- are still actually separate tables. This join is just a virtual join, and
when you add DEMO_COUSUB2010_POLY.shp to a new document, none of the income data will come
with it.

If you want to preserve this join, and make it easily available in other documents, you have two options.
You could save DEMO_COUSUB2010_POLY.shp as a layer file, which will keep all of its current
formatting including the join. Or you could save it as a new shapefile, which would not keep the
formatting, but would permanently join the tables.

The layer method has the benefit of not duplicating your data, but also means that if you were to share
the data, you would have to remember to pass on several files: If you save it as a new shapefile, you
would duplicate your data, which makes it harder when you update either the
DEMO_COUSUB2010_POLY.shp shapefile orincome table, but your data would all be contained in
one shapefile.

In this exercise you will save the joined data to a new shapefile.

a) If the attribute table is not already open, then right click on
DEMO_COUSUB2010_POLY.shp and select OPEN ATTRIBUTE TABLE.

b) Leavethe ATTRIBUTES TABLE open, right click on DEMO_COUSUB2010_POLY.shp in the
Table of Contents, and choose PROPERTIES.

c) Click on the FIELDS tab.

d) Uncheck any fields that you don't think you will need in your exported shapefile.

e) Click OK to close the PROPERTIES window, and then close the attribute table.

f) Rightclick on DEMO_COUSUB2010_POLY.shp, and choose DATA - EXPORT DATA.
g) Navigateto C\INTROGIS\DATA)\, and name the new file MEDIAN_INCOME.shp.
h) Click OK in the Export Data dialog.

i) Click YEs to add the new data to your map.

i) Rightclick on MEDIAN_INCOME, and open the attribute table.

k) Scroll across the table. Notice that all of the population fields are present, and that the field
names no longer show the source table prefix.

[) Close the attribute table.

m) Save your map.
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CHAPTER 8 Edit Data in ArcMap

In ArcMap, accidentally editing the actual geography of your data (or easily changing its attributes) is
prevented by an extra step: opening an editing session.

In this chapter, you will start an editing session and create new features, define their attributes, and
alter existing features.

1. Edit Features

In this exercise, you will edit an existing polygon shapefile. Using aerial photographs for reference, you
will digitize new polygons and split, reshape, and attribute existing ones.

a) Start ArcMap and open an empty map document. Add some VCGI statewide aerial imagery via
Web Map Service, then add ENVIRON_MAREA2004 _POLY.shp

" Creste Features rx

b) From the CusToMizE menu, select TOOLBARS, and then click the T - 0 <Search> - @
EDITOR TOOL-BAR. ENVIRON_MAREA2004_POLY

DENVIRON_MAREA 2004_POLY

c) Dock the EDITOR TOOLBAR at the top of your screen.

d) From the EDITOR menu on the new toolbar, choose START EDITING.

e) You need to select the folder or workspace in which you will edit.
You can just select the layer (or one of the layers) you wish to edit,
and its workspace will become editable.

f) Double-clickon ENVIRON_MAREA2004_POLY to start editing. -
. . | Construction Tools
g) The Create Features window may appear. It is probably docked at G ogon
the right hand side of your screen; if not, dock it there now. g Rectangle
Circle
Editor 7| » P s o AN E SNt o2 2B R @ Ellipse
O Freehand
="/ Stop Editing 1. Auto Complete Polygon
B ssverdts | Auto Complete Freshand
Move...
Merge...
# Buffer...
Union...
v
Snapping 3
More Editing Tools »
Editing Windows 3 ”T[:r Create FEEILIIES‘
Options... D Attributes
[A] sketch Properties
] shared Features
Adjustment Preview
Control Points
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h) The top of the Create Features window displays the layers that are
available for editing. In our example, only
ENVIRON_MAREA2004_POLY is available. When you single-click
on it, Construction Tools appear in the lower window.

i) Start by clicking on Polygon in the CREATE FEATURES pane

ENVIRON_MAREA2004_POLY
[ |ENVIRON_MAREA2004_POLY

[ Construction Tools

€2 polygon

] Rectangle

O circle

© Ellipse

2 Frechand

1% Auto Complete Palygon
| Auto Complete Freehand

f)  Now you will start to digitize an additional managed area to add to the Green Mountain National
Forest. Pick an area to the east of the existing polygons, and not touching them; click all the way
around its border. When you are done, you can double-click or press F2.

The field you just digitized does not touch any of the already digitized areas. If you want, you can
practice drawing a few more isolated polygons.

As you started editing, you probably noticed the semi-transparent FEATURE CONSTRUCTION TOOLBAR that
followed your cursor around. It contains tools that could conceivably be helpful (and that you will use
later in this chapter) but the toolbar sometimes really gets in the way! If you want the toolbar to stay
visible, but get out of your way, just click the TAB button. After you have practiced with editing a bit, you
may decide that you want to close the toolbar and not use it at all; if that is the case, go to EDITOR >
OPTIONS > GENERAL tab and remove the check mark next to “Use mini toolbar.”

2. Save Your Edits

While you are editing, you need to remember to save your edits regularly -- possibly after adding each
new feature.

a) To save your edits, pull down the EDITOR menu and select SAVE EDITS.

b) To save your map, click the SAVE button on the STANDARD TOOLBAR.

Saving your edits and saving your map are two different things. You must remember to save your
edits! Simply saving your map will not do so!!
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3. Reshape an Existing Polygon

Pretend for a minute that you are not happy with the job you did tracing that field, and want to change
(reshape) a bit of it.

Editor-| » N |[Z]e A2-4  NYdh 2~ 2| B @A E-“fﬁ

Reshape
Select tool Edit Vertices

a) Click on the SELECT tool on the EDITOR TOOLBAR.
b) Selectthe polygon you just drew by clicking on it.
¢) Click on the RESHAPE tool on the EDITOR TOOLBAR.

d) Starting outside your polygon, digitize a half circle that dips into your polygon and finishes
outside of it again. Double-click or press F2 when you are done.

- |Create Features 7 x

B~ B <Search> -@

ENVIRON_MAREA2004 POLY
[ JEMVIRON_MAREA2004 POLY

Cms(md'xm Tools

<2 Polygen

[T] Rectangle

() Circle

© Ellipse

2r Freshand

1L Aute Complete Polygon
| Auto Complete Frechand

"o | Creste Features ax
T+ B <Search> - @

ENVIRON_MAREA2004_POLY
[CJENVIRON_MAREA2004_POLY

[ Construction Tools

{2 Polygen

[] Rectangle

(D Circle

O Hlipse

2 Freehand

I Auto Complete Polygon
| Auto Complete Frechand
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f) See what happens if you do it the opposite way: start inside the existing polygon, digitize a line

g) Click on the EDIT VERTICES tool on the EDITOR TOOLBAR.

h) A new small toolbar is added to your view.

that dips out of the polygon and finished inside of it again. Another way to change the shape of
your polygon is to move individual vertices.

i) You can select and drag any of the vertices of your polygon. You can use the + and - tools on the

i) Save your edits.

4. Digitize Abutting Polygons

Edit Vertices tool bar to add and delete vertices. When you are done, click F2

When digitizing polygons, one would frequently want to create polygons that perfectly abut one another --
that is, they completely share a boundary, and do not slightly overlap or have small gaps between them.
This would be very difficult to do if you simply tried to trace along an existing boundary as you digitized a
new polygon. Luckily there is a special construction tool just to accomplishit: the Auto Complete

Polygon tool.

Now you will create a polygon for the managed area to fill in an area not currently in the GMNF. Using
Auto Complete Polygon to make it abut an existing polygon.

a)

b)
c)

Choose the Auto Complete Polygon tool
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-click outside the polygon t
% B &

= Create Features

T - T <Searchs

Hold down the Shift key and select polygons surrounding an area that is mostly within GMNF.

Click outside the new polygon\o start delineating the area, click along the approximate

boundary of the area, then dou o finish your delineation.

ax

-a

ENVIROM_MAREA2004_POLY
[ |ENVIRON_MAREA2004_POLY

i Construction Tools
43 Polygen
Rectangle

ircle

@ EMfigse

2 Freehygd

2] Auto Complete Polygon

< Auto Complete Frechand




The actual shape of the area you digitize does not matter right now -- just be sure that you understand
where to start and finish when using this tool. To digitize polygons that perfectly abut other polygons, first
you must select the existing polygons, then start and finish editing within them.

d) After you have completed your polygon, double-click or press F2.

e) Save your edits.
5. Create a New Shapefile

In this exercise, you will create a new shapefile representing either an additional managed area
or something more meaningful to you!

Before you can start drawing the property boundary, you will need to create an empty shapefile to work
in. You will do this in Catalog.

a) Openthe catalog window, and browse to the folder C:\INTROGIS\DATA.

b) Right-click on the folder name and choose New > Shapefile.

c) Name your shapefile New_Polygon, and make it a polygon shapefile.

Create Mew Shapefile lé
Hame New Polygon
Feature Type Foiygon -
Spatial Feference
Deesacriplion:

Urkrover Coordinale System

gl
Show Dictals [Ex '

Cocrdnates wil contan M values. Used to store route data
Cocrdnates wil cordan 7 values Usad io store 30 daia

QK Cancel

d) Click the Edit button at the bottom of the window to define the new shapefile’s spatial reference.
Choose: Projected Coordinate Systems> State Plane> NAD 83 Meters> then scroll down until you
find the VT coordinate system. Click on it then click on OK. Then click on OK again.

e) Add this new layer to ArcMap, and left click on New_Polygon in the Table of Contents to
change its fill color to none and its outline color to something bright, like orange or fuchsia.

f) Addthe TRANS_RDSMAJ1_LINE layer to your map, and click its line symbol in the Table of
Contents and change the width to 4 so that you can see it cle
TRANS_RDSMAJ1

f) Rightclick on New_Polygon in the Table of Contents and select Edit Features > Start Editing.
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g) Inthe Create Features window, click on New_Polygon to display the available construction
tools.

h) With the Polygon tool, begin delineating the property boundary. Start in the southwest corner.
Notice that the FEATURE CONSTRUCTION toolbar follows your cursor around for easy access.
Sometimes, however, it just gets in the way. You can grab its title bar and move it out of the

way.
Try the various buttons and tools in the editing toolbar and the create features window.

It may be a little hard to tell at first which buttons are “on” and which are “off.” It may also not be
obvious what the function of each button is —remember that Tool Tips will define the buttons for you
if you hover your cursor over them for a moment.

Next you will make a polygon follow the path of a road using the Trace tool.

e bl g A =

TRACE tool

Straight Segment tool

a) From the Feature Construction toolbar, choose the third option — the Trace tool. Click on the
nearest road, and follow it as it forms the boundary of your property.

b) When you get to the end of the bounding road segment, click once to finish tracing, and then
switch tools again. From the Feature Construction toolbar, choose the first option - the

Straight Segment tool.

c) Continue until you have delineated the entire boundary. When you are done, you can double click to
finish your sketch, press F2, or choose the Finish Sketch button on the Feature Construction toolbar.

d) From the Editor menu, choose Save Edits.
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CHAPTER 9 Symbolizing Data

In this exercise, you will work through several different methods of symbolizing data, using town and county
data and 2010 census data. ArcGIS uses the information in a layer’s attribute table (such as county name
or population) to symbolize the data.

After working through some of the Symbology options, you will probably begin to get an idea of how
much work can go into making a data set look the way you want it to. It would be very time-intensive to
go through that effort each time you wanted to use a common data set. Fortunately, you do not have to-
-you can save the Symbology (and more) as a layer file.

In ArcGIS, a layer stores the Symbology, query, labeling, and other qualities of a theme that you have set
in your map document. Your map is really made up of layers -- the document does not contain the data
files themselves, but pointers that reference the data files. But unless you explicitly save a layer file, all
of the Symbology you set in your map is only saved in the map document itself, and cannot be used in
other maps.

In this exercise, you will learn how to save a layer file outside of your map, so you can later add it to other
maps. When you make a new map and want to include the same kind of features, you can add the layer

instead of the base shapefile, and all of the Symbology will be included. Remember that a layer file does
not actually include the data itself— it references a data set stored elsewhere.

1. Symbolize Using Unique Values
In this example, you will symbolize each county with a different color.
a) Open a new, empty map. If ArcMap is closed, start it up and choose a blank map at the

template/intro screen. If ArcMap is already open, click the NEw MAP FILE button at the upper
left (on the STANDARD TOOLBAR).
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a)
b)
c)
d)

Q New Document

Choose a template for your new map a
= MNew Maps My Templates e
My Templates [ .
= Templates i I

= Standard Page Sizes -
#rchitectural Page Q Ty
150 (4) Page Sizes _ 3] \_I
North american (4|

= Traditional Layouts
Industry Exeter_NRI_Template Blank Map
Usa

World

Browse for more... : :
Architectural Page Sizes

< » ARCH & Landscape ARCH A Portrait v
C:\Documents and Settings'Jim Deely\Application Data\ESRI\Desktop10.04ArcMap\Templates\Normal. mxt

Default geodatabase for this map: What is this?
\GIS\ArCGIS Defailt.gdb v

Choose Blank Map from the New Document dialog.
Click the Save button and navigate to CAINTROGIS\PROJECTS

Name your map Symbology.mxd.

In the ArcCatalog pane, browse to INTROGIS\DATA and add DEMO_TOWNPOPN_POLY and

Boundary CNTYBNDS

Right-click on the name Boundary CNTYBNDS in the TABLE oF CONTENTS and choose the last
option, PROPERTIES. (Alternatively, just double-click on the name BOUNDARY_CNTYBNDS.)

Take a minute to browse through the PROPERTIES window (double- click a layer name or right-click |
properties to open this window). This is where you can change all these different properties that affect
how a layer is drawn in your map — including labels, transparency, fields to be displayed, and
symbology.

Selectthe SYMBOLOGY tab at the top of the PROPERTIES window.
Do the following steps to symbolize each county with a unique color:

i. Onthe far left, click on CATEGORIES, then on UNIQUE VALUES.

ii. From the Value Field menu, choose CNTYNAME.

iii. Click the ADD ALL VALUES button near the bottom of the window.
iv. Choose a color ramp that seems appropriate.

v. Click OK.
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Layer Properties [ ]

| General | Source | Selection | Display | Symbology | Fields | Definion Guery | Labels | Joins & Relates | Time | HTML Popup |

Slz:;m Draw ies using unique values of one field. Impot.
Categories Value Field Color Ramp.
e - IR -
a
na
Label Count
<al other values> 0 |
CNTYNAME 14
ADDISON 1
BENNINGTON 1
CALEDONIA 1 |
CHITTENDEN 1 Y
ESSEX 1
FRANKLIN 1
GRAND ISLE 1
LAMOILLE 1 .
id Al Valudy, | [ Add Values... | | Femove | [ RemoveAl | [ Advanced -

/ \ [0k ) [ Camee | [ Aok |

Each county should now have a different color on your map.

You can also classify colors based on values — try using Quantities | Graduated Colors, instead of
Categories, and “area” instead if CNTYNAME — and choose a color
e Notice how your map is now ordered in color by area for each county

2. Change Line Symbology

In this exercise you will change the line symbology for DEMO_TOWNPOPN_POLY.

a) Make sure DEMO_TOWNPOPN_POLY is above Boundary CNTYBNDS in the table of
contents. You will noticed that the towns now completely hide the counties.

b) Double-clickon DEMO_TOWNPOPN_POLY to open its PROPERTIES window.

c) Make sure you are on the SYMBOLOGY tab at the top of the PROPERTIES window.

d) Do the following steps to symbolize the town boundaries:
i. double-click on the Col.%tchﬁenemﬂ Source | Selection | Display Symbology I Fields | D

O

. iy
ii. Choose the hollow color swatch Draw all features using the sam

iii. Click on “edit symbol” bol

Categories
Quantities

Mt n

iv. Click on “outline”
v. Scroll down to learn about various line symbol options. Pick one and click on it.
vi. Click OK many times until you are back at your map, with the new town

boundary Symbology applied.
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File Edit View Bookmarks Insert Selection Geoprocessing Customize  Windows Help
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Table Of Contents 4 x
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j) Save your map!

4. Symbolize with Graduated Symbols

a) In the Towns layer properties window, click on
GRADUATED SYMBOLS under the QUANTITIES heading.

(o eleie i, g [* /T
i ey
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b) Setthe VALUES FIELD to POPN2000

c) Click the TEMPLATE button if you want to change the symbol.

7
o

"*Oé?
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7

d) Click the BACKGROUND button if you want to change the
background color.

e) Click OK.
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CHAPTER 10 Working With Labels

There are many different ways of adding text to your map -- some are very quick (and usually don’t
look great) and some will take quite a while (and can be customized until they look just the way you
want them).

In this exercise, you will use graphic labels to label the counties on your census map, use dynamic
labels to define road and highway shield labels, and use dynamic labels to label all the towns in the
state. You will also set up scale-dependent rendering for some of the labels, so that your map is not too
busy with labels when zoomed out, and finally convert labels to annotation so that they can be used
again in other maps.

1. Add Graphic Labels

a) Returnto your population map in ArcMap. It should be saved in the CAINTROGIS\PROJECTS
folderand is called Symbology.mxd

b) If ArcMap is not yet open, open ArcMap using the desktop icon, and select Symbology from
the existing maps list. You may have to click “Browse for More” to locate it.

c) If ArcMap IS already open, click the OPEN FILE icon and browse to the population map.

Make sure that you are in DATA VIEw (not LAYOUT VIEW). One way to identify this is to see if the display
looks like a page of paper, with margins around the edges — this is layout view. You can also check if
the LAYOUT TOOLBAR is active; if you are in data view, each tool will be grayed out (as below).

Perhaps the easiest way to confirm that you are in Data View is simply to click the data view button at the
bottom of the screen. If you are already in Data View it won’t do anything; if you are in Layout view it will
switch you over.

/

When you are labeling your data, do so in data view. If you are labeling your map page (such as adding
atitle or date), do so in layout view. This chapteris about labeling data, so we will work primarily in data
view.

a) Make sure the DRAW TOOLBAR is visible -- it is usually docked at the bottom of the screen, and
has a menu called DRAWING on its left side.

Drawing'm - A- g) Avial v10 vB I U AP+ o F

x

b) Ifitis not already visible, go to CUSTOMIZE > TOOLBARS > DRAW.

c) Turn off all layers except BOUNDARY_CNTYBNDS. You should see just the county boundaries.

d) Choose the TEXT tool from the DRAW TOOLBAR. Do this by clicking the A on the Draw

Toolbar. (It should be the sixth tool in from the left; it is not available, you may have to click on
the arrow next to whatever tool is visible there, and choose the A from the menu that appears.)

«

0] Arial 10 +vB 1T U A~ 2. .2

Drawing ~| &
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e) The NEW TEXT tool allows you to type text on your map. If you do this in Data View, the text
will move with your data as you pan and zoom the data; if you add the text in Layout View it will

stay in one place relative to the map page. Here, you will use the NEw TeXT tool to label the
counties, so we are working in data view.

NOTE: When you use the New TexT tool, you will manually type in the text you want on your
map. Later you will use tools that automatically bring in text from the data’s attribute table.

f)  Click in the middle of any county you know and type the name. You can use the
tools on the Draw Toolbar to change the font, font size, color, etc. of your text.
Continue to add county names for the rest of VT's counties. You will need to pick up
the text tool again (click on it) each time you want to type a new name.

FRAMKLIN
GRA ORLEANS
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If you do not already know the county names, this would actually take some effort to figure out from your
GIS data -- you would need to return to the metadata, look at the numerical county codes for the towns,
and find the county name that corresponds to each numerical code.

Note that the text that you add with the NEw TEXT tool is selectable and editable. If you want, you can
select a piece of text and move it to a new location, change its color, double-click on it and change the
text itself, etc. Use the arrow tool on the TooLS TOOLBAR to select the text. t

The arrow tool is a handy, neutral tool to return to whenever you want to “drop” whatever tool you
currently are using.

2. Use the Label Tool
In this step you will practice using the LABEL tool, which will add text to your map by drawing from the
data’s attribute table. You will be labeling individual towns in VT.

a) Turnon DEMO_TOWNPOPN_POLY in the Table of Contents. Turn off any other layers that
might be visible.

b) Zoom in a bit to focus on a few towns. (A scale of 1:400,000 or so may be good.)

c) Choose the LABEL tool from the Draw toolbar. Do this by clicking the tiny triangle next to the A
on the Draw toolbar -- this will give you a menu of tools to choose from. Select the one that
looks like a little luggage tag.

Text
Splined Text
Label

Callout
Polygon Text
Rectangle Text
Circle Text

PREETDE>

Drawing = K O-

d) With this tool, click a few times in the middle of different towns.

This tool works on whatever VISIBLE layer is on top in the Table of Contents. In this example, we have
only one visible layer, so that is what it is labeling: BOUNDARY_TWNBNDS_POLY. Sometimes, you
may have many visible layers and not want to turn the rest off. In that case, you can temporarily drag
the layer you want to label to the top of the Table of Contents, and remember to drag it back to its
original position when you are done labeling.

When you choose the tool and click on your map, you will be prompted with a LABEL TooL OPTIONS
window. You may use the default options (letting the computer choose the best placement, and using
the properties set for the layer). Alternatively, you can change these options: have it place the label
wherever you click, and/or choose a label style through this dialog.
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P

Label Tool Options -

Placement
-.@.-Automaticallyﬁnd best placement.
(") Place label at position clicked.

Label Style
() Use propetties set for the feature layer.
(@) Choose a style

Label Styles:
US. Route LS. Interstate =
HWY
AaBbYyZz aBbYyZ
Country 1 Country 2

AaBbYyZz  AaBbYyZ:z

Country 3 Capital -

e) Notice that the computer automatically labeled each town you clicked with the town name as it
is recorded in the DEMO_TOWNPOPN_POLY attribute table. That is because the GIS by
default set the name field as the label field. You can change these settings in the layer
properties.

3. Use Dynamic Labels

It would be difficult and tedious to label every town in the state using the label tool. Instead, there is an
easier option: dynamic labels. This will automatically label every feature in a layer -- in this case,
every town in VT.

a) First, use the arrow tool to select the town labels you just added. k

b) Click the Delete key on your keyboard to delete them. (You can draw a box with the arrow around
multiple labels, or hold down the shift key while you click on multiple labels.)

c) Double click on DEMO_TOWNPOPN_POLY in the TABLE OF CONTENTS to open its PROPERTIES
window.
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Layer Properties X
| General | Source ; Selection | Display | Symbology | Fisids | DEﬂHﬂiOD__Q!._Ie_Q'j Labels | Jains & Relates | Tme | HTML Popup |
[¥] Labe! features in this layer
Method: | Label all the features the same way. -
All features wil be [abeled using the options specified
Text String
Label Field! TOWNNAWE + | Eopression.
Text Symbol
6] ral [
AaBbYyZ: e
= MW® 7 0 sma. |
Other Options Pre-defiied Lbel Style
| Placement Popeties . | [ SceleRange. | [ Lobel Styles |
oK | [ Cancad | [ Aopy

d) Click on the Label tab.

For each layer that you add to a map, ArcMap chooses a Label Field -- usually “Name” if that is a heading
in the attribute table. You can change these default settings -- for example, you could decide that you want
to label your towns with their acreage rather than the town name. We will choose “TOWNAME”

e) Puta check mark in the box in the upper left hand corner of the window to “Label features in
this layer.”

f) Click OK.

Hooray -- every town is now labeled! And if you are still zoomed in, it might even look OK. However, as
you zoom out to the whole state, you will see why this method has some drawbacks: the labels are
generally too large for the towns, and -- worse -- they are not selectable or editable. (Try it -- grab the
arrow tool and try to select those labels: it just doesn’t work.)

4. The Label Manager

There are a number of ways that you can refine your labels: change the text size to something smaller;
set a scale dependency so that they only show up when you are zoomed in; convert them to annotation
so that you can edit them individually. If your map is going to always be an electronic map that you will
actively zoom in and out of, changing the text size and setting a scale dependency are good options. If
your map will be a printed map and/or will always be viewed at the same scale, converting to annotation
will allow you to really fine-tune the labels’ appearance.

Like so many things when working with ArcGIS, there are several different paths you can take to get to
the same result. Here, you can refine your labels in two different places: the LABELS tab of the
PROPERTIES window, or the LABEL MANAGER available through the LABELING TOOLBAR.

If you have ArcGIS v.10.1 or higher, you also have a choice of two different labeling methods: the
standard label engine or the Maplex label engine. (Maplex was available in earlier versions, but only as
an extra extension to the software.) The Maplex Label Engine has a number of special tools for
controlling the labels; in general, these will probably make your labels look better, so we will use Maplex
in this exercise.
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a) From the CusToMmIZE > TOOLBARS menu, choose LABELING.

b) Dock the Labeling toolbar at the top of your screen. The LABELING toolbar and the LABEL
MANAGER that you can access through it work with both label engines -- standard and Maplex.
First you will quickly check out how the LABEL MANAGER works and the label options available
with the standard label engine.

c) Click the firsticon on the toolbar to open the LABELING MANAGER.

Labeling ~ 45 th fy & &1 &% ||Fast = |

Along its left hand side, the LABEL MANAGER displays a list of the feature layers in your TABLE OF
CONTENTS. Along the right hand side, it displays basically the same label options that you would find
in any layer’s PROPERTIES window, such as you worked with in the previous exercise.

Label Manager &J
Label Classes
=[] TRANS_RDSMAI1 LINE % T
v a
VATER_W/BDBVT_POLY 7 Label Field:  RTNAME -

Default
O BOUNDARY_TWNBMNDS_POLY Text Symbol

i ¥l Default -
@] arial - 8 -

AaBbYyZz
[ B

Placement Properties
Orientation Position

() Horizontal [¥] abave
@ Parallel [T on the line
() Curved [Ceelow
() Perpendicular Offset: 0 map units
{Sca\e Range... ] [ SQL Query... ] [ Label Styles... ]

Options '] I Clear all l [Summary...]

The main benefit of using the LABEL MANAGER when working with the standard label engine is simply that
it collects all the different layers together in one place so you can manage their labels together.

Feel free to apply some changes to the DEMO_TOWNPOPN_POLY label settings. For example, you
may want to experiment with the placement options (horizontal vs. straight (e.g., following the long axis
of the polygon)) or set a scale range. When you are done, click OK to close the LABEL MANAGER.

5. The Maplex Label Engine

a) From the LABELING menu, choose USE MAPLEX LABEL ENGINE.

b) Zoom in a bit if necessary to see the effect of switching to Maplex. You should see that some
town names are now on two lines (“stacked” labels).

R TT———

Labeling= 5 4 “dh <5 1 <k [Fast
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c) Openthe LABEL MANAGER by clicking the first icon on the LABELING toolbar. Note that the
label options are slightly different now.

¢) Change the PLACEMENT PROPERTIES from “Regular Placement” to “BoundaryPlacement”. Click
OK to see the effect of your changes.

e) Scrollin and out on your map to see how the labels scale with your map. (You may find this
easiest using the scroll wheel on your mouse.) Note the scale at which you think the labels get
too crowded -- is it 1:100,0007? 1:300,0007?

f) Returnto the LABEL MANAGER window again. If you like, adjust the font and font size, then click
APPLY.

g) Click the ScALE RANGE button at the bottom of the window.

h) Now click the ScALE RANGE button at the bottom of the label manager window, and within the
dialog that pops up, enter the smallest scale at which you think your labels looked OK. You may
also want to enter a large scale beyond which you wouldn’t want them to display -- it can look

strange to be zoomed in to a very localized area and have a town name in the middle of your map.
Values like 1:400,000 and 1:24,000 typically work pretty well.

Scale Range [ 2 ﬁ]
e M

You can specify the range of scales atwhich labels will be shown.

Use the same scale range as the feature layer.

@) Don't show labels when zoomed:

Outbeyond: 1:500.000 ~ (minimum scale)
N
In beyond: 1:24,000 » (maximum scale)
ll [ OK l | Cancel | |

i) Click OK and OK to close the LABEL MANAGER window. Zoom in and out on your map to
explore the scale dependent label rendering you just set up.

6. Convert to Annotation

If you want to really get into your labels and change them individually, you have two options: either you
can start with graphic labels (like the County labels you added manually), or you can start with
dynamic labels and convert them to annotation.

Annotation is wonderful in that it can be saved outside of your map in a geodatabase and added to
multiple maps, just like any other data set. Each piece of text (such as each town label) is a separate row
in an attribute table, and all of the text’s properties (font, angle, color, etc.) are attributes in that table.

The downsides to using annotation are that it can be time-consuming to set up (though if you use it
frequently, it will certainly save you time in the long run); the labels are no longer dynamic -- that is if you
change a value in the source data (like fix a typo in a town name), that will not be reflected in the label;
and they are specific to one map scale -- they will not zoom in and out with your data. So annotation is
most useful for printed maps and electronic maps that are intended for a specific scale.
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In this exercise, you will convert town labels to annotation for a hypothetical map that will be at 1:200,000.
a) Zoom your map to 1:200,000.

b) Make sure your town labels are visible and are an appropriate size for this scale. If not, make
the necessary changes in the BOUNDARY_TWNBNDS_POLY properties window to fix it.

c) Create a geodatabase in which to store your annotation. From the catalog pane, expand the
catalog tree so you can see the INTROGIS\DATA folder. Right click on the folder and select
NEW > FILE GEODATABASE.

d) Name the new geodatabase TownAnnotation.gdb.

Thompson & Mesene ~ Catalog 2 x
g e oy @ Ealy

s Purchase Location: [ PoliticalBoundaries -
B0.7 ac. .
Sargerts Purchase H 8 b3 163006@&058fb13111&8d6 -
16559.6 ac + 3 Config.Msi
+ EJ Drivers
+ E3 DriversPermitl0
H B GIS
= £ IntroArc10
(;;:.; (;:aﬂt -| £ Data i
ik 2] =] Political ey
=] pbash (5 Copy
& pbpsh B Paste
Jackson 5 B Road
42758 ac. =l hoads | X Delete
¥ & Projects R
# E3 MSOCache . ¥
+ £ Perflogs ~ Refresh
Bl Folder | New ol |3
Hadieys Purchase I _: File Geodatabase 1 Item Description...
47404 ac. A  Personal Geodatabase ™ Properties..
3 Spatial Database Connection...
&3 ArcGIS Server Connection...
Layer... raw
?;;MLO;:;W Bar W -Croup Layer am_AerialPhotos
47ea1 ' Shapefile... AerialPhotos
@ Toolbox
EJ dBASE Table
&  Address Locator...
& Composite Address Locator..
@ XML Document

[+ 3 DRGs
+ E3 DrinkingWater
H E3 Ecoregions

e) Rightclick on the layer name BOUNDARY_TWNBNDS_POLY in the TABLE OF CONTENTS and
select
CONVERT LABELS TO ANNOTATION.

f) Inthe window that appears, confirm that the selections are to store annotation in a database
and the reference scale is 1:200,000.

g) Click the browse button to identify the geodatabase where the annotation will be stored
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Store Annotation Reference Scale

@/In a database Inthe map 1:200.000

Create Annotation For
@ Allfeatures Features in current extent

Feature

Linked Annotation Feature Class

[pbpAing) P

F

Feature Layer

Destination: ~ Unknown

| Convert unplaced labels to unplaced annotation | Cancel

h) Browse to the new geodatabase you just created and double-click to open it. Click SAVE.

i) Instead of the default name BOUNDARY_TWNBNDS_POLYAnNno, name the new feature
class BOUNDARY_TWNBNDS_POLYAnno_200k. This way you know the scale at which the
annotation should be used. You could conceivably create several different annotation layers for
different scales.

j) Click CONVERT.

k) Noticethat a new layer has been added to the TABLE oF CONTENTS -- this is the annotation. Turn
it off, and then on again.

[) Becauseitis a new layer, just like the other layers in your map, it can now be edited.
However, that will require starting an editing session - We will work on that later in the Develop
New Data chapter.

m) Turn the layer off for now, as the next exercises will work on adding other refinements to
dynamic labels.

8. Use a Label Expression

So far, you have used a field directly from the attribute table to label your data. You can instead
formulate an expression for your labels. In this example, you will label each town with its name AND
acreage.

a) Openthe DEMO_TOWNPOPN_POLY Properties window again. On the label tab, check the
box at the top: “Label features in this layer.” (This turns the labels back on; converting to
annotation earlier automatically turned them off.)

b) From the Label tab on the PROPERTIES window, click EXPRESSION.

c) Enter the following statementin the Expression window:

[TOWNNAME] & vbNewLine & round(([area]/1000000),0) & " sq. Kilometers"
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d) You can also enter the field names [TOWNNAME] and [area] by clicking on them in the field list at
the top of the Expression window.

Label Expression ==
Expression | Maplex
Fields
| Doube-dickto add  feld nto the expression Shon Type -]
FID ad
FPss
TOWNNAME
oy

area
len

Show Values... | [7] Display coded valu description

Expression

Write the expression in the language of the selected parser.  [] Advanced

[TOWNNAME] & vbNewLine & [area] "sq meters”

»

[ veiy | [ meset | [ e | [ Losd. ][ Save..
parsr:

This is a great place to click the HELP button -- it gives a lot of examples of ways to build expressions,
with helpful reminders of the necessary syntax.

e) Click OK, and then OK again to apply your changes. Depending upon the current scale of
your map, you may need to zoom in to see the labels.

f)  Once you have checked them out, you can turn them off. The quickest way to turn labels on
and off is just to right click on the layer name in the Table of Contents and click on Label
Features.

Remove

Open Attribute Table

Joins and Relates 4

%> Zoom To Layer

o

Visible Scale Range 4

Use Symbol Levels
Selection 4

T’_ Label Features
| Edit Features F
S5 Convert Labels to Annotation...

| %o Convert Features to Graphics...

Data 3
* Save As Layer File...
| @ Create Layer Package...

| f  Properties...
Frww-

59



8. Save a Layer File

The changes you made to the layer properties for DEMO_TOWNPOPN_POLY can be savedin a layer
file -- as can all the settings in the Properties window. This way, the next time you add the
DEMO_TOWNPOPN_POLY.lyr layer to a map, it will include the label settings you just designed.

a) Rightclickon DEMO_TOWNPOPN_POLY in the TABLE-OFCONTENTS, -

g & Copy [
x |
b) Choose SAVE AsS LAYER FILE. Remove
Open Attribute Table

c) Browse to C:\INTROGIS\DATA o i Jomsand Relates »
| & Zoom To Layer |
d) Save your map.

Visible Scale Range i

Use Symbol Levels

Selection g
~’ Label Features

Edit Features -

%4 Convert Labels to Annotation...

%o Convert Features to Graphics...

\ Data 3 |'

Save As Layer File... n
@’ Create Layer Package...

i Properties.. |

You may have noticed that sometimes labels take a long time to draw each time you zoom or pan your
map. You can click the PAUSE LABELING button on the LABELING TOOLBAR to just stop labeling for the
time being. You will need to click the PAUSE LABELING button again to resume labeling.
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CHAPTER 11 Introduction to Geoprocessing:
Dissolve and Buffer

In this chapter, you will evaluate lakes and ponds in a particular county within VT. Your goal is to
identify any waterbodies larger than 10 Acres, establish a 150 foot buffer zone around those
waterbodies, and report the total acreage of lakes and ponds plus buffer within the watershed.

You will use the following processes and tools to complete the analysis: select by attributes, select
by location, export, dissolve, buffer, calculate geometry, and statistics.

1. Set Up Map Document

a) Open ArcMap.

b) At the start screen, choose a template for your map. Go to TEMPLATES - STANDARD PAGE SIZES -
NORTH AMERICAN (ANSI) and highlight TABLOID (ANSI B) PORTRAIT. DON'T HIT OK YET!!!

) ArcMap - Getting Started u—J@ LX
Open existing map or make new map using a template EE %E
—|-Existing Maps 5 =

U st Legal Landscape Legal Portrait
Browse for more...
- New Maps
My Templates
£ -Templates 8.5in. 8.5in
tandard Page Sizes . 1 i
- Architectural Page
0 (A) Page Sizeq
rth American (A Letter (ANSIA) Landscape Letter (ANSI A) Portrait

raditional Layouts

m

Tabloid (ANSI B) Landscape Tabloid (ANSI B) Portrai]

‘4 11 » -

C:\Program Files\ArcGIS\Desktop10.0\MapTemplates\Standard Page Sizes\North American (ANSI) Page Sizes\Tabloid (ANSI B) Portrait.
Default geodatabase for this map: What is this?
C:\Users\Anne\Documents\ArcGIS\Default.gdb B
—— ' ©

:':Dn not show this dialog in the future. [ 0K ‘ Cancel ‘

Now you will define a default geodatabase for the map -- this will be the geodatabase where you put any
results of your processes. You do not need to define a default geodatabase|and in fact you could keep all
of your results as shapefiles, but it is handy to put it all in one geodatabase

c) Click the browse button next to the default geodatabase pathname!

d) Browseto CAINTROGIS\DATA.
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Q) ArcMap - Getting Started

]

Open ex

isting map or make new map using a template

To|[Eg
ozo\ag

£ Existing Maps
cent
~-Browse for mare...
(= New Maps
My Templates
(- Templates
- Standard Page Sizes
t-- Architectural Pag|
150 (A) Page Siz|
- North American
(=~ Traditional Layouts

ANSI D Portrait

Legal Landscape

Letter (ANSL A) Portrait

ANST E Landscape

Legal Portrait

Tabloid (ANSI B) Landscape

ANSLE Portrait

Letter (ANST &) Landscape

Tabloid (ANSI B) Portrait

Default geodatabase for this map:
C:\INTROGIS\DATAYakesponds. gdb

C:\Program Files (x86)\ArcGIS \Desktop10. 1\MapTemplates\Standard Page Sizes\North Ameri

[~ Do not show this dialog in the future.

ican (ANSI) Page Sizes\Tabloid (ANSI B) Portrait.mud

What is this?

-

e) Click the NEw FILE GEODATABASE button.

Default Geodatabase

=

Look in: [EI AshuelotPond

FeR Bl Erlaleans

MName:

Show of type:

B AshuelotPond

AshuelotPond.gdb

Add

Geodatabases

'I l Cancel I I

A

d) Name your new geodatabase LAKESPONDS and hit enter.
e) Select the new geodatabase, LAKESPONDS, and click ADD.

On the opening dialog, click OK.

f) Click the DATA VIEW button to switch away from LAYOUT VIEW.
g) Save your map in the PROJECTS folder. Name it LAKESPONDS.mxd.

2. Select By Attributes

The first step is to figure out where the Winooski River watershed is, and then you can select all the
lakes and ponds 10 acres or bigger that are within it.

a) Openthe Catalog pane and add three data layers:
CAINTROGIS\DATA\BOUNDARY_TWNBNDS_POLY.shp
CAINTROGIS\DATAWATER_DLGLAKE_POLY
CAINTROGIS\DATA\WWATER_WBDS8VT_POLY

b) Right-clickon WATER_WBD8VT_POLY and choose OPEN ATTRIBUTE TABLE.
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c) Click the SELECT By ATTRIBUTES button at the top of the table window. (If you aren’t sure which
button it is, hover your pointer over each until the tool tip appears and you find SELECT BY

ATTRIBUTES).
Select by Attributes @

Enter a WHERE clause to select reconds in the table window.

Method : [Create a new selection v]

“AD*
"HUC_8"
"SUBBASIN"
"HUC_2"
"HUC_4" -

E "Passumpsic. Vermont." -
‘Riviere Saint-Francois’

"Upper Connecticut. New Hampshire, Verr

S E
“Winooski River’ -

L LR — r

Get Unigue Values | Go To:

SELECT * FROM WATER_WBD8VT_POLY WHERE:
"SUBBASIN" = "Winooski River’ -

»

[

Clear H Verify ][ Help H Load... H Save... ]

(oot ][ Close |

d) Create the following expression: "SUBBASIN" = 'Winooski River'

e) Click AppLy, then CLOSE.

f) Click the Zoom TO SELECTED button at the top of the table window.
Close the attribute table
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3. Select By Location

Now you will select any lakes and ponds polygons that intersect the selected watershed
a) If you haven't already, turn on the WATER_DLGLAKE_POLY layer.
b) From the SELECTION menu, choose SELECT BY LOCATION.

c) Choose to select features from the target layer, WATER_DLGLAKE_POLY, that intersectthe
source layer, WATER_WBDS8VT_POLY. Make sure to check the button nextto “Use selected
features”

=

.
Select By Location @

Select features from one or more target layers based on their location in
relation to the features in the source layer.

Selection method:

select features from -

Target layer(s):
WATER _DLGLAKE_POLY
[ WATER_WEDSVT_POLY
[0 BOUNDARY_TWNBNDS_POLY

[ Only show selectable layers in this list

Source layer:
[€ waTER weDBVT POLY I
[#]Use selected features (1 features selected)

Spatial selection method for target layer feature(s):
=
[ Apply a search distance

20000.000000 Meters

about select by location oK I [ Apply ] l Close

d) Click OK.

The lakes and ponds within the Winooski Watershed should all have been selected. If all the lakes and
ponds in the state were selected, you may have forgotten to check the “Use selected features” option,
or you may have accidentally cleared your selected watershed. Repeat the above steps if necessary to
select the appropriate wetlands.

4. Export to New Layer

Right now the lakes and ponds within the Winooski Watershed are all selected, but that selection would
be easily lost if you accidentally clicked the clear selection button. Make the selection permanent by
exporting those lakes and ponds to their own layer (in this case, not a shapefile, but a feature class
within your geodatabase).

a) Rightclick on WATER_DLGLAKE_POLY and choose DATA > EXPORT DATA.

b) Click the browse button to browse to your new geodatabase.
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c) Click the Go To DEFAULT GEODATABASE icon at the top of the Saving Data window to navigate
directly to your default geodatabase. Name your new feature class WinooskiWS_lakesponds.
Make sure that the file type is set to File and Personal Geodatabase feature classes rather
than Shapefiles.

Saving Data

Lookin: | BLAKESPONDS gdb | W3 SEri2adw

Harme: WINSERINS_Iskesnonds / Save
SeEve B8 bype: Cancel

Fibe and Fersonal Geodatabase fealure dasses -

d) Click SAVE, then OK.

e) Click YEs to add the resulting data as a layer.

f) Remove the state-wide lakes and ponds data. Right click on WATER_DLGLAKE_POLY and click
REMOVE.

g) Click on the clear selected features button in the toolbar.

h) Save your map.

5. Summarize Data by an Attribute

The lakes and ponds in this watershed have various values for RECCODE. You can easily calculate
the acreage of wetlands in each of these categories using the Summarize function. Note that this will
create a new, stand-alone table not connected to the geodatabase.

a) Open the attribute table for WinooskiWS_lakesponds.
b) Right click on the field RECCODE and choose SUMMARIZE.

c) Expandthe ACRES field and select Sum. Name the output file Winooski_ponds_types_acres
and save it in your geodatabase.
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sert Selection Geoprocessing  Customize Windows Help

9| summarize (=)} . jz & =

1| Summarize creates a new table containing one record for each unique value
of the selected field. along with statistics summarizing any of the other fields

1. Select @ field to summarize:

RECCODE -
2. Choose one or more summary statistics to be included in the

output table:
® CODE -
[ WATERBODY
 NAME
£ ACRES

[ Minimum 18

[ Maximum
[] Average
Sum

[] Standand Deviation =

=|| Saving Data

L@ lekesponds.gb et @ EE

[ Varanca L N
ol Mame Type
3. Specify output table:

CAINTROGIS\DATAwinocski_ponds_feccodes_scres.dl 23]

Lookin:

[

Summarize on the selected records oriy

=

1| sbous summaren e Cancel

El [] 3

w2 m| ] 4 1 958

Y s | P ——

S| sm] ] 0| VT17-03L02 4| GREA

52| 436 1 E] 0 [VT17-02L08 4 [HoLL] | Saveastype e and personal tables - [ cancal |
0 [ 0 0 [] 958

(0 out of 960 Selected)

d) Click OK, and add the resulting table to your map.

e) Because it is a stand-alone table and not attached to locational data, the TABLE OF CONTENTS will
switch to “Source” view so that you can see the new table. To open it, right click on its name and
choose OPEN.

Create a new field in this table by using the Table Options drop down menu on the top left of this
table and choosing “Add Field” — call the new field Acres, and choose “Double” for the type

H Find and Replace...
By RS, By Attributed... RECCODE | Count_RECCODE Sum_area
5 1 0 3 1777516.32535
z 2 10 1520354.43015
B switch Selection 3 3 3 3180646 81645
ciia P} 4 E) 3913254.1377
. 5 988 93| 1131779645 205848
|| addField... V' |

f) Rightclick on the field name Acres and choose FIELD CALCULATOR. Calculate the field Acres to be
equal to ([Sum_Area] /0.0929)/43560.

Field Calculstor o |
Forsel
@ ¥8 Sevpn Fythan
Fiel> Types Funcbors:
CRECTID Mamber s T
HNTTIPE ! o T
Lol _HNTTAPE ] E:" 5
G AREA P )
priier L bt}
Log [ }
TR |
H S ) i
W Tani )
Codebock ol Lol bl el il =
IFS_ATeS] N1 0S29N43560 -

g) Notice that you could have also created this Acres field when you were making this Summarize table by choosing
to sum Acres as well as area, although many Field manipulations are done using the field calculator as above
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6. Dissolve Boundaries

a) Add ENVIRON_MAREA2004_POLY to your map. This is “Managed Area” that is largely
within Green Mountain National Forest. Right click the layer’'s name in the table of contents
and choose zoom to extent. Then zoom in to a scale of about 1:100,000 and pan to an area
with a lot of features.

b) Using the IDENTIFY tool, draw a box around multiple “managed areas”.
\

Selectio Geoprocessing  Customize Windows  Help
& - | 0000 - EGEE 2 edtor-

@ B2 ASS T,

T

A

\ 1 A
e .
Identify o x : ﬁ}\ T
,—_E Identify fom: [ <Top-most layer> =]
t 1| E-ENVIRON_MAREAZ004_POLY =
Location: 465,632,389 169,392.664 Meters
Field value
FID 2
Shape Palygon "
MACODE  8.1A
TRACT_NR JE.
ACQ_DATE  12:00:00 AM
GIS_ACRES 1988790033
OWNER GMNF
area 80485226797
len 52727.573936 Q

Identified 27 features r
Drawing~ K O~ A- @] Al 10 ~ B I U A-Hh-F.

f\
J7
L

c) Click on several of the features listed in the top window. You will notice that the
individual delineated areas highlight as you click on them.
d) Close the Identify Window.

We will use the dissolve tool to remove the internal boundaries between these smaller polygons.

To find the DISSOLVE tool, you can either browse through the SysTem TooLBOX (found at the bottom of the
Catalog window) and hunt & peck through it, or add the SEARCH window and use it to find the tool.

The search feature can be used to find maps, data, and/or tools. You can add new file folders to its
index and set its indexing options by clicking the options button.

Before you can search a new folder or location, you need to set the location on your network in
which you want to enable your search. This is done by adding a location and creating an index of
the tools and data available (this process is not needed to search for built-in tools like Dissolve).

d) Click the SEARCH window button at the top of the screen.
e) Click the INDEX/SEARCH OPTIONS button.
f)  On the INDEX/SEARCH OPTIONS dialogue, click AbD.

g) Browse to your CAINTROGIS\ directory and click SELECT. At the bottom of the dialogue, click

INDEX NEW ITEMS. When the indexing status is set to Active, the new index is built and ready
for search. Click OK.
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h) Dock the SEARCH window on the right hand side of the screen next to the CATALOG window. Set
it to AUTO HIDE.

i) Type “Dissolve” in the text box and hit enter.

j) Selectthe DissoLvE (DATA MANAGEMENT). Note that there are 3 hyperlinks for each result. The
first link opens the tool itself, the second link opens a Help description of the tool the third
link locates the tool within the toolbox folder.

Search
«s e

ALL Maps [Data Tools Images

3] ~ ILocaI Search

Idissolve

Any Extent =

Search returned 7 items v

#,, Dissolve (Coverdge) (Tool)
Createz a new coverage by merging adjacent pol ne, lin...
toolboxes\system toolboxes\coverage tools.thx\data mana...

"\ Dissolve (Data Management) (Tool)
Aggregates features bazed on specified attributes.
toolboxes\system toolboxes\data management tools.thx\g...

-"V% Dissolve Network (Network Analyst) (Tool)
Creates a network dataset that minimizes the number of li...
toolboxes\system toolboxes\network analyst tools.tbx\net...

-"\ Dissolve Route Events (Linear Referencing) (Toaol)
Removes redundant information from event tables ar =epa...
toolboxes\system toolboxes\linear referencing tools.thad\di...

Occasionally tools from the search results can be difficult to open on the workshop computers. If your
dissolve tool does not open, expand the Catalog window and scroll down to the bottom so you can see
the SysTeEM TooLBOX. Then click the third hyperlink in the DissoLVE (DATA MANAGEMENT) search results
(“toolboxes\system toolboxes\data management tools.tbx\generalization\dissolve”) -- this should locate
the tool within the toolbox folder, and you can open it from there.

i, Dissolve = | B |
1 | CAINTROGIS\DATA\ENVIRON_MAREA2004_POLY shp ER= .
| Output Feature Class =
€:\INTROGIS \DATAVakesponds. gdb MAREA2004_POLY_Dissolve =)
Dissolve,_Field(s) (optional)
[C] FID
[T MacoDE
[C] TRACT_NR.
[C] AcQ_DATE
[7] c1s_acres
[] owNER
[ area
[en
[ seectan Unselect Al | Add Fiekd
Statistics Field(s) (optional) i
Field Statistic Type: E]
x
1t
+
<[ I v
[7] Create muttipart features {optional)
(] Unispit lines (optional) e
oK Cancel Eny 5. | | ShowHelp >> | [
| o) v e
J

l)  Whenthe tool opens, enter ENVIRON_MAREA2004_POLY as the Input features, and set
the output feature class to be CAINTROGIS\DATA\lakesponds.gdb\MAREA2004_POLY
_Dissolve. Remove the checkmark at the very bottom of the window (you will have to scroll
down) so that you do not create multipart features. Click OK.
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m) While the dissolve process is working, you can still work on your map. Called Background

0)

p)

Geoprocessing, this is particularly evident during very complex, time consuming geoprocessing.
If you prefer, you can also turn off Background Geoprocessing from the Geoprocessing Options
window, available from the Geoprocessing menu.

You will know the dissolve process is working if you notice (eventually) the status

“Dissolve...Dissolve...” scrolling at the bottom of your screen, __2:Dissolve...Disc@ Pos:

When it is complete a green checkmark will appear, and the new data layer will be added to
your map.

The dissolved Managed Arealayer does not contain any of those internal boundaries, nor does it
contain all of the information associated with the original data (when the polygons are lumped
together during this dissolve process, you are losing the attributes from the finer scale?)

. Wdentify from: [ <Top-most layer> =

[=-MAREA2004_POLY _Dissolve
- 19837.624045
4375,035456
13907.099577
1130.326099
1602.614919 =

Location: 498,255,943 121,571.868 Meters

Field Value

OBECTID 41

Shape Polygon
Shape_Length 19837.624045
Shape_Area  4335540.977649

ing> K O-A- @] Aval Identified 27 features

7. Calculate Acreage

a)

no

b)

c)
d)
e)
f)

9)

You will now calculate the acreage of your new aggregated managed areas

Add Field k. \_' |

Right click on MAREA2004_POLY_Dissolve Neme Acres
and choose OPEN ATTRIBUTETABLE. L s .
Click the OPTIONS button at the top of the table. F‘:'I‘_j PR
Choose ADD FIELD. T
Name the new field “Acres” and set its type to Double. |
Click OK.

[ OK ] ‘ Cancel

Right click on the new Acres field and choose CALCULATE GEOMETRY.
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h) Click YEs to continue even though you are not in an edit session.

i)

Set the units to Acres US (ac) and click OK.

Calculate Geometry

S5

Property: Area

z)

Coordinate System

@) Use coordinate system of the data source:
PCS: NAD 1983 StatePlane Vermont FIPS 4400

(71 Use coordinate system of the data frame:
PCS: NAD 1983 StatePlane Vermont FIPS 4400

Units: [acres Us [ad]

Calculate selected records only

About caloulating geometry

8. Buffer Polygons

Now we will go back to the ponds and lakes data and select those that are at least 10 acres and
buffer them by 150 feet.

a) Click the SELECT BY ATTRIBUTES button at the top

e)

of the winooskiWS_ponds attribute table.

Select all wetlands that are greater than or equal to
10 acres. Note that you must click the operator button
For >= (“greater than or equal to”). It will not work if you

click the > button and then click the = button!
(Doing that introduces an extra space)

c) Click AppLy, then CLOSE.

Select by Attributes

Enter a WHERE clause to select records in the table window.

Method Create a new selection

"OBJECTID"

With those large ponds and lal
run the buffer tool. You can fin

kes selected, you will now
d the buffer tool by hunting

around in the SYsSTEM TOOLBOX, by using the SEARCH
window, or by going to the GEOPROCESSING menu.
Several of the most common Geoprocessing tools have
quick links from there (including Dissolve, which you
searched for earlier; it is helpful to know how to search

for tools!)
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SELECT * FROM winooskiws_ponds WHERE:

"ACRES" == 10 -
Clear ] [ Werity ] [ Help ] [ Load... ] [ Save... ]
=




a)

b)

c)
d)

f)

9)
k)
h)

From the GEOPROCESSING menu, choose BUFFER.

#, Buffer =] ® -
Input Features
| winoaskiws_ponds -
Output Feature Class
C:\INTROGIS\DATA Yakesponds. gdb\winoasking_ponds_150ftbuf
Distance [value or field]
©) Linear unit
) Field
Side Type (optional)
OUTSIDE_OMLY -
£nd Type (optional)
ROUND
Dissolve Type (optional)
Dissolve Field(s) (optional)
[£] oBIECTID -
[ ma11
[ Mt =
] Masz
7] Mz

Set the input to WinooskiWS_ponds and name the output winooskiwS_150ftbuf.
Set the LINEAR UNIT to 150 feet, the SIDE TYPE to ‘FULL’, and the DiSSOLVE TYPE to All.
Click OK.

Open the attribute table for the buffers.

Click the OPTIONS button and choose ADD FIELD.

Name the field Acres and set its type to Double. Click OK.

Right click on Acres and choose CALCULCATE GEOMETRY

Set the units to Acres US (ac) and click OK.
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CHAPTER 12 Introduction to Geoprocessing:
Clip and Spatial Join

In this chapter, you will determine the existence and location of boating access recreation sites in
proximity to 10 acre or larger ponds and lakes in the Winooski Watershed, as well as identify the roads that
could lead you to those boating access sites.

You will clip the recreation boating sites layer to Washington County and evaluate how many points (if
any) fall within 150 feet of the lakes and ponds that are 10 acres or greater in area.

Next you will evaluate which roads lead to these access points. To do this, you will identify the roads and
clip them with the buffers. Then you will conduct a spatial join of the road segments to the recreation
sites. This will add attributes to the recreation sites table describing the nearest section of road and its
distance to the recreation site. Finally, you can work to symbolize the resulting data in a way that
effectively communicates your results.

1. Set Up Your Map Document

a) Open ArcMap. If it is already open, save the existing map and click the NEw MaAP FILE button. EI

b) At the start screen, choose a template for your map.
Go to TEMPLATES - STANDARD PAGE SIZES

- NORTH AMERICAN (ANSI) and

IGM.UL.:. - ety e - -
highlight TABLOID (ANSI B) PORTRAIT. o i i i e
c) Define a default geodatabase for the map
d) Click the browse button next to the defauli
geodatabase pathname. g -
g) Browseto C\INTROGIS\DATA\ (el i K / |
h) Click on The NEwW FILE GEODATABASE et e I |
bUtton' : g F xr -u.u. Wi | g Titalin il L ST e e ST P ke, | lidedl | AL N .-,,-.-:i
. - g
Default Geodatabase Y ﬁv_‘b
!LWL in:  |EJ Crticeiaciibies - A EH B EAOW

:r i boatingsites

|
|
|
|
|
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f) Name your new geodatabase boatingsites and hit enter.

g) Selectthe new geodatabase, boatingsites, and click Abp.

h) Onthe GETTING STARTED dialog, click OK.

i) Click the DATA VIEW button to switch away from LAYOUT VIEW.

j) Save your map in the PROJECTS folder. Name it Winooski_boating_access.mxd.

k) Add the following data layers from the C:\INTROGIS\DATA\ folder:

i. BOUNDARY_TWNBNDS_POLY
i. TOURISM_RECSITES_BOATING_POINT
ii. TRANS_RDSMAJ1_LINE

I) And the following from your lakes and ponds geodatabase:

iv. WinooskiWS_ 150ftbuf
v. WinooskiWS_lakesponds

2. Clip a Data Layer

In this step you will clip the Recreation Sites layer to the boundaries of Washington
County. First you will need to select all the towns in Washington County to form your clip

layer.

a) From the SELECTION menu, choose SELECT BY ATTRIBUTES.

b) Setthe Layer to BOUNDARY_TWNBNDS_POLY, and create the query “CNTY”

county code for Washington County.) Click OK.

™
Select By Attributes M°
= i

RN~ ounoay wenos o |
[] Only show selectable layers in this list II
Method: [Create anew selection v]
FID" -7
FIPSE" I |
TOWNNAME Fi
CNTY" g |
"area” - ||
==
a0
SELECT * FROM BOUNDARY_TWNBNDS_POLY WHERE:
"CNTY" =23 -
Clear ] [ Verify ] [ Help ] [ Load... ] [ Save.. ]
o) Cawr ) (e ]

—_—

c) From the GEOPROCESSING menu, choose CLIP.

d) Setthe INPUT layer to Recreation Sites.
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e) Setthe CLip layer to BOUNDARY_TWNBNDS_POLY. (Make sure you drag it in from the
TABLE OF CONTENTS or select it fr
system to find it. You need to u
County towns.

Input Features

ITOURISM_RECSITES_BOATING_F‘O
Clip Features

|BOUNDARY_TWNBNDS _POLY ™
Qutput Feature Class

L L

I CAINTROGIS\DAT A boatingsites. gdbWashington_boating_access

¥Y Tolerance {optional)

the drop-down menu -- do not browse out to the file
the layer in which you have selected the Washington

IMeters

1 S [ 5 [

f) Name the output feature class Washington_boating_access and confirm that it is being saved in

the boatingsites.gdb geodatabase.

g) Click OK.

h)

layer from your map by right-clicking on its name and selecting REMOVE.

3. Select By Location

Now you can figure out which, if any, of the boating site are
within 150 feet of a lake or pond 10 acres or more in size.

a) From the SELECTION menu, choose
SELECT BY LOCATION.

b) Selectfeatures from the target layer,

Washington_boating_access that intersect the source
layer, WinoooskiWSponds150ftbuf

c) Click OK.

4. Create an Attribute Flag

In this step you will “record” the results of the previous step by
creating a new attribute in the boating sites attribute table, and
calculating its value for the selected records.

a) Openthe Washington_boating_access attribute table.

b) Click the OpTIONS button and choose AbD FIELD.

When the clip is complete, remove the statewide TOURISM_RECSITES_BOATING_POINT

Seliegt By Lovsten -
SouctimaTy Fom e 3 mOre LG . S O S L P
ek 1 o bapLen e B e
P L
b fa
Tarit mvra)

¥ wambingon_Ecasng sccsan
[ s Rovials L
T e
[ e pords _{Bifin
imE Tl 3,
ety s e it ey o laf
s by
[ T =]
5 bratrry
Lo i et e gt e Wrhe el
st S o o S -
o bgie w s g
150 [Fedd
Sl L o oy P

c) Setthe Name to bufferpond the type to text, and the length to 1.
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x

Name: Ibuﬁerpund
Bee: e <]
— Field Properties

Alias bufferpond

Allow MULL Walues Yes

Default Value

Length 1

d) Click OK.

e) Right click on your new field (all the way at the end of the attribute table) and choose FIELD
CALCULATOR.

f) Remember that the only records selected right now are those that are in the buffer area; you are
going to calculate their boating access point value to “Y” for “yes.” Just type a Y in double quotes
(“Y™) in the window and click OK.

feacamnr T e

Farser
@/VE Senipt Pythan
Falds: Typa: Funicticns:
OBIECTID z A f::; ]J
SMPE = fﬂﬁ{ ]
D String e ( )
SECCLASS Fif )
Date L

HAME nty{ )
TELEFHONE ;:;1'[ ]:'
ADDRESS 'S-ur{t y
ADDRESS? Tam{ )
Iy
STATE x

Show Codablogk 'f'l’&' e [iag] [im
o s ==
= -

g) Now you will calculate the bufferpond value for all the other records to “N”.

h) Click the switch selection button at the top of the table. |

i)  You should notice that different records are selected now. These are all the sites that are
not within 150 feet of the selected ponds.

i) Rightclick on bufferpond and select FIELD CALCULATOR.
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k) Type “N”in the window and click OK.

[) Clear selected features and save your map.
m) How many sites are in within 150 ft of a pond that is 10 acres or larger in size?

5. Perform a Spatial Join

In this final analytical step, you will perform a spatial join of the roads data to the boating access points.
This means that for each point the computer will calculate which is the closest road segment, and will
append its attributes (with its name, road class, etc.) to the boating access attribute table. It will also add
a new field, Distance, which will contain the distance (in feet) between the boating access point and the
closest road segment.

a) Right click on Washington_boating_access.
b) Choose JOINS AND RELATES > JOIN.
c) Choose to join data based on spatial location, and select the layer TRANS _RDSMAJ1_LINE

d) Choose the second option-- each point will be given all the attributes of the line closest to it, etc.

Join Data o]

A | 3oin lets you append additional data to this layer's attribute table so you can,
for example, symboiize the layer's features using this data.

What do you want to join to this layer?

[30in data from another layer based on spatial location -

1. Choose the layer to join to this layer, or load spatial data from disk:

& TRANS_RDSMAT_LINE i

2. Youare joining:  Lines to Points
Select a join feature dass above. You will be given different
options based on geometry types of the source feature dass
and the join feature dass.

Each poirt wil be given a summary of the numeric attibutes of
the lines that intersect it, and a count field showing how mary
lnes intersect t.

How do you want the attributes to be summanzed?
Average Wirimum Standard Deviation
Sum Madimum Variznce
@ Each point wil be given allthe atirbutes of the ne that is closest

o t, and a distance field shawing how close that line s {n the
units of the target layer)

3. The result of the join will be saved into a new layer
Specify output shapefile or feature dass for this new layer:

CINTROGIS\DATAecsites_boaling_washingion gdbJoin_

About foining dats cancel

e) Click the BROWSE button to name the output feature class. If necessary, browse to the default
geodatabase (you can click the Go To DEFAULT GEODATABASE button). Make sure the type is
set to Geodatabase feature classes (not shapefile) or it will not work. Notice the default name or
give it a new name!

f) Click SAVE and then OK.
6. Evaluate Your Results

a) Open the attribute table for the joined data.
b) Scroll all the way across to the new “Distance” field at the end.

b) Right click on the field Distance and choose SORT ASCENDING. Note that some sites are
quite close (< 500 feet) to a boating access point.

How many sites are within 500’ of such roads? How many sites are within a mile of such roads?
How could you symbolize your results to communicate them effectively? If you have time, try
some different methods.
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CHAPTER 13 Layout View

Layout View is where you prepare your map for exporting, publishing, or printing. It is where you can add
all the extra elements that enable it to communicate its message to the reader: title, legend, scale bar,
north arrow, date, text about data sources, etc. It also functions a bit like Print Preview for your map —
you can see the page margins and how all these map elements will fit together on the page.

1. Explore Layout View

a) Ifitis not already open, open your Symbology.mxd map.

So far in this workshop, you have always been working in Data View. Now you will switch to Layout

View. Layout View is where you can add the elements that your map needs to be understandable to
someone else.

b) Click the tiny Layout View button at the bottom of the ArcMap interface.

I 2326.000001 - 52324000000
I 5232000001 - 12046000000

I 12046,000001 - 42417.000000

Sy GOUNDARY.TWNBNDS POLY

¥ CNTYBHDS_POLY
rvalues

I WINDHAM
I WINDSOR

[@a|=

Drawing - K O« A~ @ < - B IO AR Des

¢) When you switch to Layout View, a new toolbar becomes available to you: the LAYOUT TOOLBAR.
(It was probably already docked in your ArcMap interface, but until you switch to Layout View, it

is all grayed out.) If it is not yet docked, drag it toward the top of your screen and dock it up
there.

The LAYouT TOOLBAR contains several tools that probably look familiar — they are very similar to the
navigation tools on the TooLs TooLBAR. To distinguish them, each of their icons has the image of a
sheet of paper in the background.

(o W 2 R 7% v | 3 Edn B

The navigation tools (like Zoom and Pan) on the LAYouT ToOLBAR and ToOLS TOOLBAR work quite
differently. The Layout tools will zoom and pan you around the map page —for example, to look closely at
the legend — while the zoom & pan from the TooLs TOOLBAR will move you around the data itself. You
can still use the data zoom and pan while you are in Layout view!
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The zoom and pan tools from the LAyouT toolbar will change your position on the layout itself -- they will
zoom in to the piece of paper, or move the paper to the right or left. They will not change the position of
the data in the map.

[ & & & E B[ 2t~ B M aa

These tools zoom in, out, amM around your page. @
/' 5

The zoom and pan tools from the TooLs toolbar will zoom in or out of the data itself, or pan the data an
around, just like they did in data view. gf:?
d) Practice using the LAyouT toolbar. @

i. Pick up the zoowm tool, and draw a box to zoom in to the layout. @

ii. Pan around the map with the PAN tool. ;ﬁ

ii. Zoom back out by clicking the Zoom TO FULL PAGE button. E] |T

i)

4

é

These tools zoom in, out, and pan around your data. |

e) Now compare what happens when you use the TooLs toolbar.
i. Pick up the zoowm tool from the TooLs toolbar, and draw a box to zoom into the data.

ii. Pan around the data with the PAN tool from the TooLs toolbar.

iii. Zoom back out by clicking the Zoom To FULL EXTENT button. O

2. Add a North Arrow and Scale Bar to your Layout
Without some standard map elements — such as a legend and scale bar — it may be difficult for others
to use your map.

a) From the INSERT menu, choose INSERT NORTH ARROW. Choose a north arrow style, and click OK.

b) The north arrow is placed on the map. It has “handles” at the corners that allow you to resize it, and
you can click in the middle and drag it anywhere on your page. If you decide you want to change
its style, just double click to open its properties and then you can change it.

c) Insert Scale Bar. Choose a style and Click OK.

d) To getthe scale bar to look the way you want it, you will have to open and manipulate its
properties.

e) Double-click on the scale bar to open its properties.
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)

h)

2.
a)

b)

c)
d)

Scale Line Properties x|

Scale and Units | Numbers and Marks I Format I Frame I Size and Postion I

Scale

Division value: 4mi
Number of divisions: I 1 _I;
Number of subdivisions: I 4 _I;

I~ show one division before zero

When resizing...

@

r~ Units

Division Units:

IMI|ES j
Label Position:

Iaﬁ:er labels j
Label: I Miles Symbal. . |
Gap: |5.1155{_|:;'

ok | cancel | &pph'\I\\

On the Scale and Units tab, try changing the instructions for resizing to “Adjust width.” Then you
can specify exactly how wide you want each division of the scale bar.

Try setting the units to Miles, the division length to 10, and the number of divisions to 5. Click OK
to see how this affects the scale bar. Feel free to play with these settings until you make it look the
way you want.

Save your map.

Add a Legend to your Layout

From the INSERT Menu, choose INSERT LEGEND. The Legend Wizard will appear.

In the first window, choose which layers to include in the legend. You may want to choose just
the census data, or the census data and the political boundaries. To add layers to the legend,
use the arrow button to move them from the left-hand pane to the right-hand pane.

Click Next through the next several windows until you can click Finish.

The Legend is placed on your map.

4. Insert a New Data Frame

Now you will insert a new data frame so your final map @ symbology - ArcMap
Cal’.] _InCIUde two geographlc areas -- o_ne a view of File Edit View Bookmarks Insert Selectior
pDc;llJltgcal boundaries, and the other a view of Census DB Ea B - +-
RAN@ 23« -0 K
a) Rightclick on the name Layers at the top of your Table Of Contents 7 x
Table of Contents -- this is the name of your current FReY A
data frame (the only one now in your map). Itis the [ "= pojtical Boundaries
default name that ArcGIS always gives to the first = [] BOUMDARY TWNMENDS_POLY
data frame in a map. Select PROPERTIES. -
BOUMDARY_CNTYBMNDS_POLY
b) On the GENERAL tab, make the name “Political i
Boundaries.” Click OK. BESgPopuiation)
=] DEMO_COUSUEB2010_POLY
P0030001

[770.000000 - 998.000000
[77998.000001 - 2326.000000

[ 2326.000001 - 5282.000000
[ 5282.000001 - 12046.000000
79 I 12046000001 - 42417.000000




¢) Fromthe INSERT menu, choose DATA FRAME. Your
map may disappear -- that is ok! In data view, you can
only look at one data frame at a time, and you are now
looking at your new, empty one.

d) Scroll down (if necessary) in the Table of Contents,
and right click on NEw DATA FRAME. Select PROPERTIES.

e) Onthe GENERAL tab, make the name “Population”

f) Click OK.

5. Copy Layers between Data Frames

The current “active” data frame will be in Bold type text in the Table of Contents, and only the layers
from this active Data Frame will be visible in Data View. If your new Population Data Frame is active (
you can make it active if it is not by right-clicking on its name and choosing “Activate”) and if you were
to click the Add Data button right now, the data would be added to the Population data frame, not the
Political Boundaries one. Another way to get data in to the data frame is just to copy or drag it in from
the other data frame — this will make a virtual copy of the data for viewing and mapping, not a real

copy.

a) Drag the Census data from the Political Boundaries data frame down to the Population data
frame

6. Become comfortable Changing the Active Data Frame

Right now, the data frame Population is active--thatis, it is visible in the DISPLAY AREA, and its scale is
reflected in the scale box at the top of the window, and if you were to pan or zoom, you would be doing
so in the Population data frame.

a) To view the Political Boundaries data frame, right click on Political Boundaries in the TABLE OF
CONTENTS, and select ACTIVATE. — note the scale

b) Return to the Population data frame by right clicking on Population and selecting ACTIVATE, and
notice that you are in a different scale now.

9. Arrange Data Frames in Layout View FQJE” == 1]
a) Switch to LAYOUT VIEW by clicking the small paper icon at the bottom of the screen.

b) Temporarily turn off the census data in each data frame to speed up the time it takes
your map to redraw as you move things around.

c) Adjustthe sizes of the two data frames so that Political Boundaries takes up the entire
page, and Population is just a small box. You can adjust the size of a data frame by
selecting the data frame and dragging on any of its handles.

80



Q) symblogy - ArcMag
File E&t View Bockmarks lnset Selection Geoprocessing Customize Windows Help

@& +Hax " & - | 12250048 | BEE o
BEMO e - Ll ] pall ) g
Tabde Of Contents Bx PO L O I O .

HAS8 3
[@ & Pokibeal Boundumics
O BOUNDARY_TWHNENDS_POLY

=]
+ F BOUNDARY_CNTYENDS POLY

= B DEMO_COUSUB2010_POLY
POO30001
] 0.000000 - 958 000000
] 996 000001 - 2326000000
0 2326.000001 - 5282.000000
I 5252.000001 - 12046.000000
I 1.2046.000001 - 42417.000000

13, (10 |10 12 (13 qie 15 |18

[LALA

4 15,18,

F T

- 4

e on
Orawing= I -1 %8 Ol = A = ¥ ESHI Nerth R I A

5376 © @ S(ElE § R[Q

Remember to use the Zoom and PAN tools from the TooLs toolbar, not the
LAYOUT TOOLBAR

d) Save your map.

8. Insert Text

a) Click on the NEw TexT tool on the DRAWING toolbar.

b) Click anywhere at the top of the page to insert a text box.

;

| Drawing > K &[0~ A~ = |[aial ~l <] 2 zu A- >~ g~ o~

\

You are adding text in Layout view, so the text will stay with your map page as you zoom around
or change the extent of your data. This is just like how you added text labels in Chapter 6, but in
that case you added them in Data view, so the text stayed with your data as you changed its
extent.

c) Change the font size to 24 (type it in the font drop down box, and press enter).

d) Double-click on the text box to bring up the TExT PROPERTIES dialogue.
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e) Type “Political Boundaries and Population of Vermont - 2010” in the title text box. Press OK.

Properties

Ted | Size and Posttion

Teat

Palitical Boundaries and Population of Vermont - 2010

il
1l
m .

Fort:  Anal 24.00

Angle: 0.00 Character Spacing:  0.00
Leading. 0.00

About formatting text

Change Symbal.

f)  Drag the title to the top of the map.

g) From the INSERT menu, choose DYNAMIC TEXT > CURRENT DATE.

h) The date is added as a text box in the center of your map. Drag it to a bottom corner, and

make the font smaller.

i) Double click on the date to open its properties. You will see that it has the word Date: followed
by some tagged text that contains the code to insert whatever the current date is. Replace the
word “Date” at the beginning wit

-
Properties

h “Map prepared:” Click OK.
. > o WECx<

Text |Size and Position

Text

Map prepared: <dyn type="date" format="short"3|

1

Font  Adial 7.00 = = =
Angle: 0.00 = Character Spacing:  0.00 =
Leading: 0.00 =
About Formatting Text ] I Change Symbol..
[ oK l [ Cancel ] [ Apply

)

L=

9. Adjust Legend Text in the Table of Contents

It is somewhat counter-intuitive, but in order to change the text in your legend, you need to make
adjustments to the layers themselves — either in the TABLE OF CONTENTS or through the layers’

Properties windows.

a) Make sure that the Population frame is the active frame.

b) Add a legend by selecting LEGEND from the INSERT menu. Note that the layers available in

the legend wizard are based on whatever frame is active right now.
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c) Click Next through the rest of the wizard pages to add the legend to your map. You will refine
it later.

d) Remember that the legend is looking at the data in the Population data frame. Therefore, to
change the legend, you need to change the look of the census data in the Population data frame
not the Political Boundaries one.

e) Inthe TABLE OF CONTENTS, change the layer name “DEMO_COUSUB2010_POLY” to “Population
2010.” You can do this by simply selecting the text and then clicking it again to make it
editable. Hit enter when you are done.

e) You can change the number formats for the housing vacancy categories in this same manner.
For example, if the text reads, “0.000 - 0.03000", you can select it and change it to “Less than
3%” . “0.03001 - 0.08955" can become “3 - 9%”, and so on.

If you want to change the actual symbology or classification of the data (e.g., make the classes
break at whole numbers, or at equal intervals), you will need to go back to the Symbology tab on
the Properties window, click Classify, and make your changes to the Label associated with each
Range.

g) Change the name Boundary CNTYBNDS in the Political Boundaries data frame to “County
Boundaries”.

g) Save your map.
10. Tips for Working with Legend Properties

NOTE: See below (step 11) if you are working with ArcGIS version 10.0 or earlier. The legend editor
has changed in version 10.1, and the instructions here pertain to v.10.1. or greater

To change the appearance of your legend (other than the wording, which you changed in the TABLE OF
CONTENTS, above), you need to open the legend properties. Do this by double-clicking on it or by right-
clicking and selecting PROPERTIES.

The Properties window has five tabs: LEGEND, ITEMS, LAYOUT, FRAME, and Size & POSITION. Use the
arrow buttons on the Gener;?v if you want to add or remove any layers from your legend. The ITEMS

tab is where you will work to chhange many aspects of your legend’s appearance.
Legend Proghfties —

_!_E}enaai_! ftems lLayout i:?mme ETSlze and Pastian |

Apply settings to selected item(s)

| Select Al || Select None ‘ ik

to all labels &
CrT— ‘
pbp

Map Extent Options

[l Only show classes that are visible in the current map extent

[ Show feature count

Ttem Columns

! || Place item(s) in a new column
| ‘ Column count for item({s) 10

Style...
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For example, if you want to remove the heading PO03001 from the population item in the legend -- so
that it only says “Population 2010” with the symbol colors and labels below it -- you would start on the Items
page. First you need to understand that “Population 2010” is the layer name, and “P003001" is the
heading, and text like “0-998” is a label. Click the Style button, and then choose from the list of legend
thumbnails one that does not show a heading, just the layer name and labels.

Legend ltem Selector

S|

Heading

2
5
F

Horzortal Bar with Heading. Horzortal Single Symbol
Labels, and Description

- s

Horzortal Single Symbel [ ’
Label Only Layer Name and Desciption|

Layer Name Heading

i,

- 0K Cancel

Preview

Propertes...
Mare Styles =
Save Reset

As you click on different styles, your choice is displayed in the preview thumbnail. The defaultis to

show the Layer Name, Heading and Label; it is often nice to instead choose a style that includes only
Layer Name and Label, or even just Label.

11. Working with Legend

If you want to make the “Legend” title go away (or change it to a different word), go to the LEGEND tab and
either click the check mark next to “SHow” (to hide the title) or type new text in the text window.

Legend Properties

/ Specify Legend Items

et

General ||tems | Layout | Frame: iSize and Posmon;
Legend Items:
(=] -
pbp
(<] 4
n
Only display layers that are checked an in the Table Of Contents
[] Add a new item to the legend when a new layer is added to the map
[¥] Rearder the legend items when the map layers are reordered
[ Scale symbols when a reference scale is set
[ ok J[ Concel |[ st |

Remove the checks from the check boxes at the bottom if you want items to stay displayed in the legend
even if turned off or re-ordered in the TABLE OF CONTENTS. It can be very frustrating to set up your legend
just the way you want it, only to have ArcGIS reorder it for you when you rearrange layers in your map.
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Use the FRAME tab to give your legend a frame (draw a line around it), a solid background (rather than
transparent) or a drop-shadow. Adding a value for a gap in both the X & Y directions for the border and the
background will make increase the size of the margin from the legend to the border.

[ Legend Properties i l _-_. M

| Legend | ltems | Frame |S\ze and Positior1|

Border

N —
| BE} Color:; -‘v
Gap X 0= pts Y 0% pts  Rounding: 012 2

Background \
—_—
B% Color: | i

Gap X Ol pts ¥ 0% pts  Rounding: 012 =

Drop Shado/

7 7 B cotor: (I

Offset X 152 pis Y

-15-% pts  Rounding: 0= %

|| Draft mode - just show name

l OK J I Cancel | I Apply

12. Aligning Elements in a Layout

a)
b)

c)

d)

)

h)

Hold down the CTRL key, and select the both title text box and the Political Boundaries data frame.

Right-click and select ALIGN - ALIGN TO MARGINS. This turns on the ALIGN TO MARGINS option,
which means that the next alignment command you give will occur relative to the margins, not to
other objects on the page.

Right-click again, and select ALIGN - CENTER. Both objects are centered between the left and right
margins.

Hold down the CTRL key, and select the Population data frame, and then select the Political
Boundaries data frame (in that order).

Right-click and select ALIGN - ALIGN TO MARGINS. (This turns off the ALIGN TO MARGINS options.)

Right-click again select ALIGN - LEFT. The left side of the Population data frame, which was the
first object you selected, is aligned to the left side of the Political Boundaries data frame, which
was the last object you selected.

It may also be useful to add Guides to your map -- these are lines (invisible when printing) to
which you can snap and align objects. To add guides, simply click in the ruler area at the top and
side of the layout display window. If you don’t see the ruler or the guides, go to the View menu and
make sure both are turned on.

Save your map.
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